
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

DESCRIPTION OF  
GammaPRO 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2017 



 2

Table of Contents 
 

Introduction .................................................................................................................................................. 3 
1 Starting the programme .............................................................................................................................. 4 

2 Structure of the programme and its elements .............................................................................................. 4 

2.1 Main interface elements ..................................................................................................................... 4 

2.2 Main menu ......................................................................................................................................... 5 

2.3 Main toolbar ...................................................................................................................................... 7 

2.4 Device Manager panel ........................................................................................................................ 8 

3 Measuring and saving a spectrum ............................................................................................................. 15 

4 Work with a spectrum .............................................................................................................................. 18 

4.1 Main functions ................................................................................................................................. 18 

4.2 Work with a peak ............................................................................................................................. 22 

4.3 Material window .............................................................................................................................. 23 

4.4 Prompt window ................................................................................................................................ 24 

5 Determining activities of radionuclides by the ROI-method ...................................................................... 25 

5.1 Calculation by one spectrum............................................................................................................. 25 

5.2 Common calculation by sample number ........................................................................................... 28 

5.3 Shared beta – gamma calculation ...................................................................................................... 29 
5.4 Superposition method ....................................................................................................................... 30 

6 Determining activities of radionuclides by the individual peaks analysis method ...................................... 32 
6.1 General statements ........................................................................................................................... 32 

6.2 Procedure of calculation of activities by the individual peaks analysis method .................................. 33 
6.3 Adjustment of found peaks ............................................................................................................... 36 

6.4 Inserting and deleting peaks ............................................................................................................. 37 

6.5 Sending of a list of peaks to calibration ............................................................................................ 39 

7 Energy calibration .................................................................................................................................... 40 

8 FWHM and shape calibration ................................................................................................................... 42 

9 Efficiency calibration ............................................................................................................................... 45 

9.1 General statements ........................................................................................................................... 45 

9.2 Selection of radionuclides for calibration .......................................................................................... 45 

9.3 Efficiency calibration procedure ....................................................................................................... 46 

9.4 Management of spectra .................................................................................................................... 48 

9.5 Creating an efficiency file project ..................................................................................................... 49 

9.6 Creating an efficiency file from a text table ...................................................................................... 49 

10 Parameters ............................................................................................................................................. 50 

11 Pack of spectra ....................................................................................................................................... 52 

12 Radionuclides library editor ................................................................................................................... 57 

13 Reference source library editor ............................................................................................................... 59 

14 Calibration for activity calculation by the ROI-method ........................................................................... 60 

14.1 General provisions ......................................................................................................................... 60 

14.2 Creating a calibration file ............................................................................................................... 60 

14.3 Calibration for content calculation .................................................................................................. 62 

14.4 Calibration coefficients .................................................................................................................. 62 

15 Licence .................................................................................................................................................. 64 
Annex 2. Efficiency file structure (*.efp) ..................................................................................................... 66 
Annex 3. Passport of source file structure (*.pks) ......................................................................................... 67 

Annex 4. Calculation of confidence interval for measurement error ............................................................. 68 
4.1 ROI-method ..................................................................................................................................... 68 

4.2 Determining activities of radionuclides by the individual peaks analysis method .............................. 69 
Annex 5 Calculation of specific effective activity of natural radionuclides .................................................. 70 
REVISION HISTORY ................................................................................................................................ 71 

 



 3

Introduction 
 

GammaPRO is a software for work with semiconductor and scintillation spectrometers of 
gamma, beta and alpha radiation (such as TRIO , BOSON, AirSPEC, GCD, MCA-527, DSPEC, 
etc.).  

GammaPRO ensures simultaneous and independent control of all the connected analysers and 
spectrometric devices, and provides all the necessary tools for applied spectrometry. It allows 
measuring and processing spectra, setting parameters of spectrometric tracts and determining all the 
relevant metrological characteristics.  

GammaPRO employs different algorithms for determining activity in samples (ROI-method 
with overdetermined matrix, individual peaks analysis method, superposition method). For the 
analysis of high resolution spectra (spectra received on semiconductor spectrometers) there separate 
tools (search peaks, Gaussian approximation, identification, plotting efficiency curves, etc.). 

GammaPRO has a multi-window, easily customisable interface and provides broad 
opportunities for work with spectra (mathematical operations, pack processing, application of 
specific algorithms, conversion and translation to other applications). Automation of routine 
measurements can be ensured using a bar-code system and counter samples change mechanisms. 

GammaPRO has a platform and module structure, which allows supplementing the 
programme with application modules.  

The programme includes plug-in modules: 
 “Pack” – processing of series of spectra; 
 “Profile” – measurements in motion (car, railway car version of the spectrometer-radiometer); 
“WBC” – whole body radiation spectrometry (in chair and chamber configuration). 
 
 
System requirements: 

Windows XP/Vista/7/8/10;  
processor with frequency 1 GHz;   
USB 2.0 (for MCA-527, BOSON, MD198, MD198M analyser) 
256 MB RAM;  
100 MB of free space on the hard drive;  
keyboard;  
mouse. 
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1 Starting the programme 
 

To start GammaPRO, double click with the left mouse button on the GammaPRO icon on 
the Windows desktop, or go to Start->Programs->GammaPRO. 

 

 
 

 When the programme is started, it detects enabled analysers and their status. If there are 
many analysers, the starting process may last longer, and the detection progress can be seen on start-
up screen of the programme. To terminate the connection with enabled analysers, press Esc key on 
the keyboard. 

 

2 Structure of the programme and its elements 
 

2.1 Main interface elements 
When the programme has started, the main window of the programme will appear on the 

display (Fig.1). 
 
 
 

 
 

Figure 1. View of GammaPRO after its launch 
 

Block 1 

Block 2 
Block 3 

Block 4 
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The programme window contains four main blocks: 
- main menu of the programme (Block 1); 
- main toolbar with buttons providing access to most used dialogues (Block 2); 
- device manager (Block 3) – a panel, which ensures switching from one spectrometric tract to 

the other; 
- status bar (Block 4). 
 

2.2 Main menu 
  
The main menu of the programme includes the following items: 
 
File (see Fig.2): 
 

 

 
Figure 2. File menu items 
 

With the Open Spectrum menu item, the user may open a previously saved spectrum in a 
dialogue window.  

Four other items can quickly open recently saved spectra. 
Exit  is used to close GammaPRO. 
 
Tools (see Fig.3): 
 

 

Figure 3. Tools menu items 

Pack opens a window for working with several spectra (see section 11). 
In the Tools section, you will see names of plug-in modules such as WBC, Profile, etc. 
 
Options (see Fig.4): 
 

 

 
Figure 4. Options menu item 

Passport of source editor opens a window that allows generating files of passport data of 
source (see section 13), used in the procedure of generation of efficiency calibration files. 
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Log opens a log window, which displays saved results of conducted measurements. Data can 
be sent to the log using Add to log in the menu, which can be displayed by pressing  (Options) 
on the toolbar of the spectrum. 

Parameters opens a window with the same name, which contains general settings of the 
programme (see section 10). 

Bar-code opens a window with information about the entered bar-code, from which 
measurement with automatically completed information about the source can be started. You can 
display such a window automatically by pressing the F5 hot key. 

Library editor is for opening a dialogue, where you can work with radionuclides library files, 
as well as create and edit your libraries using the existing ones (see section 12). 

As Device manager (Block 3, Fig.1) can be separated from the left edge of the main 
programme window and can be closed, then Device manager can make this panel visible again. 

Switch on analyser allows switching on all the available analysers at once. It means that if 
analysers are physically connected to the PC and parameters of each connection are entered in the 
programme, with this item you can skip pressing Switch On in the Device configuration window 
(see Fig. 11) for each spectrometric tract separately. 

Use Russian/English to switch GammaPRO interface language. When you use this item, the 
programme will warn you than a language will change and will close. When you reopen the 
programme, the interface language will be different. 

 
Window (see Fig.5): 
 

 

 
Figure 5. Window menu items 

 
Mosaic displays windows of the spectrum as a “Mosaic”. Cascade displays windows of the 

spectrum as a “Cascade”. Minimize all minimizes all the windows of the spectrum to the bottom of 
the main window. 

Range measuring spectra ranges the spectra to be measured (those having a status 
“measurement spectrum”) in the sequence of their opening. 

Close all closes all the windows. 
 
 
Help (see Fig.6): 
 

 

 
Figure 6. Help menu items 

 
About… brings a dialogue with information about GammaPRO, as well as contact 

information. 
Help displays information on how to work with the programme. 
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2.3 Main toolbar 
 
GammaPRO toolbar looks as shown on Figure 1 (block 2). The panel is divided into groups, 

which can be moved within the panel, or “separated” from the panel and moved to some other area 
of the main window of the programme. 

The panel contains three groups (see Fig.7): 
 

 
Figure 7. Groups of the toolbar 

 
The first group Device manager contains the following buttons: 
 

 - Device configuration, displays a configuration window of the analyser (device), which 
is highlighted in the Device manager right now (Fig.1, block 3, Analysers column); 

 - Tract configuration , displays a configuration window of the spectrometric tract, which 
is highlighted in the Device manager right now (Fig.1, block 3, Channels column); 

 - Measurement parameters, displays a window with parameters of measurements for the 
spectrometric tract, which is highlighted in the Device manager right now (Fig.1, block 3, Channels 
column); 

 - Calculation parameters, displays a window with calculation (activity, etc.) parameters 
for the spectrometric tract, which is highlighted in the Device manager right now (Fig.1, block 3, 
Channels column); 

 - Spectrum view parameters, displays a window with parameters of the view of the 
spectrum (colours of elements of the histogram, background, axes, etc.) for the spectrometric tract, 
which is highlighted in the Device manager right now (Fig.1, block 3, Channels column). 

 
The second group Calibrations contains the following buttons: 
 

 - Energy calibration, displays energy calibration for the tract, which is highlighted in the 
Device manager right now (Fig.1, block 3, Channels column); 

 - FWHM and shape calibration, displays FWHM (full width at half maximum) and 
shape (left edge shape) calibration of the peak for the tract, which is highlighted in the Device 
manager (Fig.1, block 3, Channels column); 

 - Efficiency calibration , displays a window of efficiency calibration. The display of this 
window is not related to the currently selected analyser and tract. 

 
The third group Measurement is active only when there is a real connection with a real 

analyser for the current tract. The group contains the following buttons: 
 

 - Start, starts a measurement in the spectrometric tract, which is highlighted in the Device 
manager right now (Fig.1, block 3, Channels column); 
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 - Stop, stops a measurement in the spectrometric tract, which is highlighted in the Device 
manager right now (Fig.1, block 3, Channels column); 

 - Read, forced reading of the spectrum from an analyser for the current spectrometric 
tract, which is highlighted in the Device manager right now (Fig.1, block 3, Channels column); 

 - Clear, clears spectrum buffer in the analyser for the current spectrometric tract, which 
is highlighted in the Device manager right now (Fig.1, block 3, Channels column). 

The toolbar buttons described above are duplicated in the Device manager popup. Thus, for 
instance, the context menu of the Analysers column looks as shown on Fig.8. 

 
Figure 8. Context menu of the Analysers column 

 
Also, the context menu of the Channels column looks as shown on Figure 9. 
 

 
Figure 9. Context menu of the Channels column 

 
 

2.4 Device Manager panel 
 
The Device Manager panel (Fig.1, block 3) is intended for switching between analysers 

(devices) and tracts within a single analyser (if the analyser is multi-tract analyser). This solution 
allows simultaneously and operatively controlling any number of devices connected to the PC and 
spectrometric tracts, to start measurements and conduct processing. 

To choose the necessary analyser and tract, just click on it with the left mouse button in the 
table. When selecting a spectrometric tract in the Channels column, the analyser corresponding to it 
is selected automatically.  When clicking on the necessary analyser in the Analysers column, the 
first tract will be selected automatically. (Example. On Fig.8 and 9 the current analyser is 
'MCA527', the current tract is 'BDEG-63'). 
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As it was noted above, button actions on the toolbar described in section 2.3 will be used for 
the currently selected tract. 

To add or remove an analyser to the Device Manager panel there are  and  buttons in 
the table header (block 1). To remove an analyser from the list of used analysers, select the analyser 
in the Analysers table and press . 

The Channels column is also divided into two columns, first of which is intended for 
displaying the name of the tract, but the second has a timer showing the time of measurement left in 
seconds. If the field is empty, measurement in the channel was stopped or has ended (see Fig. 10). 

 

 
Figure 10 

 
2.4.1 Device configuration window 

When you press  on the toolbar or select Device configuration in the context menu of the 
Analysers column on the Device Manager panel, a window shown on Figure 11 will appear on the 
display. 

 
Figure 11. Device configuration window view 

 
Analyser name field – the name of the analyser given by the user to the current analyser and 

shown in the Analysers column on the Device Manager panel.  
Analyser type field – the type of the analyser from the list of GammaPRO-compatible 

devices.  
Address, Port fields – intended for specifying an analyser’s IP address in the network, or a 

device address on the bus, or a serial port number (including virtual) depending on the type of the 
device. If the field Address is not empty, the software attempts to establish connection with the 
analyzer which has the corresponding IP address. Otherwise, the software addresses all the available 
serial ports, one after another, attempting to establish connection to the device which has the 
corresponding serial number. 

In the Serial number field, the user can enter the serial number of the device to link the 
specific analyser to the specific position on the Device Manager panel. If the serial number is 

Timer to 
the end of 

measurement  
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unknown, leave this field blank, a serial number of the first free device of this type will be populated 
after the establishment of a connection with the device. 

Press Switch on on the right side of the Device configuration window to establish a 
connection with an analyser. If the connection has been successfully established, you will see the 
green On value in the Status field, but if there is no connection, the programme will show a 
message about failure to establish a connection. 

 
2.4.2 Tract configuration  window 

When you press  on the toolbar or select Tract configuration  in the context menu of the 
Channels column on the Tract Manager panel, a window shown on Figure 12 will appear on the 
display. 

 
Figure 12. Tract configuration  window view 

 
In this window, in the Tract name field the user may give the current tract a name, which will 

be displayed in the Channels column on the Device Manager panel.  
The Tract name field is intended for selecting the type of the detector (gamma, beta or alpha).  
In the Channels field, specify the number of channels in the spectrum. Options in the 

dropdown list of this field depend on the type of the analyser. 
The High Voltage field is intended for specifying the value of high voltage, which should be 

set for this type of detector. To actually set high voltage, press , or press  to 
remove it. 

Depending on the analyzer’s type, this parameters group may have some additional fields such 
as, for example, the following: 

- Threshold which displays the amplitude discriminator value in arbitrary units. This value 
may vary from analyzer to analyzer, this is why it should be set in accordance with a 
spectrometer’s or analyzer’s documentation. 

- Ratio CV which displays the control voltage factor indicating by which value the 
amplification coefficient should be changed to shift a peak’s position by one channel. This 
parameter is needed for a correct functioning of the reference peak stabilization system or 
auto adjustment of the spectrometry tract. 

You can access specific parameters of the analyser by pressing . It opens a 
window, which can look differently depending on the analyser type.  
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If the analyser of this tract is inactive, buttons in the Tract configuration window will be 
greyed out. 

 
2.4.3 Measurement parameters window 

When you press  on the toolbar or select Measurement parameters in the context menu 
of the Channels column on the Tract Manager panel, a window shown on Figure 13 will appear on 
the display. 

 
Figure 13. Measurement parameters window view 

 
 This window contains parameters related to the measurement procedure: 
 File name – spectrum file name, which will be generated during the forthcoming 
measurement on this spectrometric tract. The file name should be specified in full format with a path 
to the location, where the file will be located. To get to the standard file selection dialogue window, 

click in the field and press , which will appear on the right side of the field. 
 Spectrum type – spectrum format selection window. The *.asw format is the standard 
default type of spectrum for GammaPRO. 
 Preset time – exposition of the forthcoming measurement for this tract. The time unit for the 
Preset time value is specified in the Unit field. 
 Reading interval – spectrum reading and displaying interval, sec. 
 
 The Sample data section contains parameters related to the sample being measured. These 
data will be further displayed in parameters of the measured spectrum. 
 Sample ID – the identification number of the countable sample (text field). 
 Weight, Unit – mass and mass unit of the countable sample. 
 Volume, Unit – volume and volume unit of the countable sample. 
 Material  – name of the material being measured. It is selected from the list of materials, for 
which there are data on the permissible content range. To select a material, click in the field and 

press , which will appear on the right side of the field. Confirm selection of the necessary 
materials by pressing Apply (see section 4.3). 
 Comment – field for a comment about the forthcoming measurement (2 text rows). 
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 The Coefficient of concentration section contains parameters related to the method of 
preparation of the sample to be measured. These data will be further displayed also in parameters of 
the measured spectrum. 
 Coefficient – value of the coefficient of concentration, rel. units. To get help in determining 
the coefficient of concentration (including cases of radiochemical concentration), the user may open 
an additional window, where this coefficient will be calculated. To open the additional window, 

click in the field and press , which will appear on the right side of the field (see Fig.14). 
 Use – field for enabling or disabling the use of the coefficient of concentration in further 
calculations. 

 
Figure 14. Coefficient of concentration window view 

 
 The Retry of measurements section contains parameters allowing to specify and set retry of 
measurements in the automatic mode.  
 On – field to enable the retry of measurements mode. 
 Template files – file name template. 
 Iterations – the number of measurements to be conducted. 
 Pause, sec – field for setting the time between measurements, sec. 
 Directory of spectrum – the path, where any measured spectra will be saved. 
 The spectra file names are generated from the specified directory (Directory of spectrum) 
and from the template of field specified in the Template files field, plus iteration number and 
resolution.  Example of the first, second, etc. spectrum for the situation on Fig.13: 
  C:\GammaPro\spe-g\temp_1.asw 
  C:\GammaPro\spe-g\temp _2.asw 
  … 
  C:\GammaPro\spe-g\temp_10.asw 
  
 2.4.4 Calculation parameters window 

 When you press  on the toolbar or select Calculation parameters in the context menu of 
the Channels column on the Tract Manager panel, a window shown in Figure 15 will appear on 
the display. This window contains the parameters which will be the spectrum parameters when the 
spectrum has been acquired. 
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Figure 15. Calculation parameters window view 

 
 This window contains parameters related to the calculation procedure: 
 Calculation type – the type of calculation, which determines, which unit will be displayed in 
the resulting data table (specific activity, volume activity, etc.). Where,  
     'Specific activity, Bq/kg' means that during the calculation in addition to the activity the 
specific activity in Bq/kg will also be calculated; 
       'Specific activity, Bq/g' means that during the calculation in addition to the activity the 
specific activity in Bq/g will also be calculated; 
       'Volumetric activity, Bq/l ' means that during the calculation in addition to the activity the 
volumetric activity in Bq/l will also be calculated; 
     'Volumetric activity, Bq/ml ' means that during the calculation in addition to the activity 
the volumetric activity in Bq/ml will also be calculated; 
     'RFD, mBq/s·m2' means that the radon flux density will be calculated in mBq/s·m2 (see 
document Methodology of radon flux density measurement); 

    'Volumetric activity of Rn-222, Bq/m^3'  means that the volumetric activity of radon 
will be calculated in Bq/m3 (see document Methodology of radon volumetric activity measurement);     

    'Content' means that the radionuclide content will be calculated in the units of 
measurement specified by user (this is applicable in the window method, see Section 14). 
 Background spectrum is the path to the background spectrum for this spectrometric tract. A 
link to this field will be shown in parameters of the measured spectrum. 
 Calibration file (ROI-method)  – path to the calibration file, which will be used for 
calculation of activity using the ROI-method. 
 Calibration ADER  – path to file of calibration by ambient dose equivalent rate, which will 
be used automatically, when reading the spectrum and displaying it. 
 List of calibration spectra (superposition method) – path to the file list of calibration 
(reference) spectra, which will be used when calculating the activity by the superposition method. 
 The Error  section contains two parameters L  and Q, which are used in the calculation of 
errors in the procedure of determining activities using the ROI-method. For the description of values 
of the b method see Annex 4. 
 The Reference date section contains parameters allowing to set the date of activity in the 
measurement results.  
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 On measurement date – when the value in this field is enabled, activity will be calculated 
as at the measurement date, otherwise the date will be taken from the Date and Time field. 
 The Directories section contains paths to Calibration files, Working spectrum and Bkg 
spectra. These directories will open by default, when standard file selection dialogue windows open. 
 The ROI section contains parameters allowing to calculate the intensity of in the regions of 
interest. Such intensities are calculated together with and during the calculation of activity using the 
ROI-method. The result is displayed on the relevant tab on the results panel in the spectrum. 
 Calculate – the parameter enabling and disabling the procedure of calculation of intensity in 
regions of interest. 
 Subtract bkg – the parameter enabling and disabling subtraction of background in regions of 
interest, when calculating intensities. 
 File ROI  – path to the file, which contains windows of regions of interest. 
 
 The Search peaks section contains parameters participating in the search of peaks in the 
spectrum and their displaying.  
 L.limit , R.limit  are the boundary channels of the range where the search of peaks will be 
performed. 
 Level is the extreme value of the parameter related to the statistical significance of peaks. If 
this value is exceeded, a peak is accepted and added to the table; otherwise, the peak is rejected. The 
value of parameter Level can vary within the range from 0.5 (all the peaks, even those close to 
fluctuation peaks, are accepted) to 5 (only the most prominent peaks featuring significant difference 
from statistical fluctuations are accepted). The optimum value of this dimensionless quantity is 3. 
 Min.area – the limit value of the peak area in impulses. The peaks with the value above this 
one are accepted and added to the table, and below this value are rejected. 
 Type search – one of two possible types of search for peaks in the spectrum ('Search and 
Identification', 'Peaks from library' ). So, the 'Search and Identification' type searches for all the 
peaks available in the spectrum and meeting the criteria of the Search peaks section. The 'Peaks 
from library'  type envisages application of preliminary markings according to the loaded 
radionuclides library file (see the Library file  field in the Identification  section). 
 Show peaks – parameter for enabling displaying of peaks and their parameters in the 
spectrum. 
 Update peak when reading – the parameter showing the need to update peak markings in 
the process of measurement, when the spectrum is constantly changing. If a peak is added in the 
process of measurement, it is recommended to enable this parameter, otherwise there will be a visual 
discrepancy between real peaks and marked peaks. 

The Smoothing  parameters control polynomial smoothing of a spectrum relevant for a 
better peak search and description of peaks by functions. The Smoothing parameters include:  

Polynomial degree.  This parameter defines the degree of the polynomial smoothing to be 
considered for spectrum peak search. The parameter’s value should not exceed 6, and the 
recommended value is 5. 

Iteration . This parameter defines the number of smoothing iterations for spectrum peak 
search. If this value is 0, no smoothing will be performed. Spectra featuring high statistics should 
not be smoothed, and the parameter’s value for such spectra should remain 0. 
 The Identification section contains parameters participating in the identification of the peaks 
found in the spectrum. 
 Library file  – path to the radionuclides library file, which will correspond to the measured 
spectrum. The library file contains a list of radionuclides, their energy values, probability of outputs 
and half-lives. Library files are generated using the Library editor  dialogue (see section 12) and are 
used in the process of calculation of activity using the peaks analysis method. 
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 Efficiency file – path to the efficiency calibration file, which will correspond to the 
measured spectrum. The efficiency calibration file contains a dependence of the efficiency of 
registration on gamma-quantum energy and is used in the process of calculation of activity using the 
peaks analysis method. The efficiency file is generated using the Efficiency calibration dialogue 
(see section 9). 
 MTP . This parameter is the so called peak thickness factor, or, in other words, the distance 
at which two peaks are indistinguishable. The value of this parameter is set in arbitrary units in the 
range between 3 and 10. In case two peaks close to each other are processed separately as if they 
were singlets (i.e, each peak has its own background substrate) but they are supposed to be 
processed together (I,e., so that they have a common background substrate), the calculation should 
consider this parameter and be repeated until the peaks are processed together as a multiplet. 
 Allowable dev., keV – the energy deviation parameter, within which a peak may be assigned 
to a characteristic curve of some radionuclide. 
 
 2.4.5 Spectrum view parameters window 

 When you press  on the toolbar or select Spectrum view parameters in the context 
menu of the Channels column on the Tract Manager panel, a window shown on Figure 16 will 
appear on the display. 
 

 
Figure 16. Spectrum view parameters window view 

 
 This window contains parameters describing the appearance of spectra for this spectrometric 
tract such as background colour, histogram of the spectrum, grid, axes and marker. When the 
Default colors parameters is enabled, colours will have their default values. 
  

3 Measuring and saving a spectrum 
 
 For the purposes of measurements, the user must first select an analyser and a spectrometric 
tract to work with. To do this, left click on the respective tract in the Device Manager. To perform a 
measurement, make sure that the selected analyser is connected and a connection with it has been 
established (see section 2.4.1).  

 
It should be noted that the analysers connected via the USB interface (BOSON, MCA-

527, Polynom, etc.) require installation of drivers, which should be installed in addition, after 
the programme has been installed. When you have connected your device to the PC (by 
connecting a USB cable and switching it on), Windows will discover a new device in the system 
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and will offer to install a driver, which is located in the relevant directory of the programme 
(by name of the device). Specify this path and then Windows will install the analyser.  

 
Before starting measurements, set the time of measurement. This can be done in the 

Measurement parameters window (see section 2.4.3). In this window, you can also set the file 
name, if needed. Other parameters are also set in the Measurement parameters window and in the 
Calculation parameters window, when needed (see section 2.4.4). 

When the analyser is ready, control buttons (Start, Stop, Read and Clear) on the main 
toolbar will be clickable and coloured in, otherwise, all the buttons will be greyed out and inactive. 

To start a measurement, press , then a window of the spectrum to be measured will 
appear (Fig. 17), which will show a histogram.  

 
 

 

        
Figure 17. Window of the spectrum to be measured 

 
 
The window of the spectrum to be measured differs from the spectrum, which is opened, by 

presence of redundant buttons allowing to control the measurement on the toolbar (see Fig.18). 
 

 
Figure 18. Group of buttons for control of a spectrometer on the toolbar of the window of the 

spectrum to be measured 
 

The spectrum to be measured has a connection indicator on the toolbar, showing the event 
of programme’s contact with the analyser (the indicator gets red, when they exchange data). 

After the start, the window with the spectrum is updated with the interval specified in the 
Measurement parameters window (see section 2.4.3).  

 
 
During a measurement, the Device Manager panel will display a countdown timer as shown 

on Figure 10. When a measurement ends, a message shown on Figure 19 will appear on the display. 
 

Spectrum 

Marker 

Indicator of 
spectrum 

reading from 
the analyser 
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Figure 19 

 
The message is asking whether you want to save the spectrum to a disk. If the spectrum was 

previously named, then the spectrum will be saved automatically, but if no name was assigned to the 
spectrum, the programme will offer to enter a new file name and specify its saving location. 

To force-stop writing a spectrum in the process of measurement, press . The message 
shown on Figure 19 will appear on the display again.  

If the user closes the spectrum window after a measurement, it can be restored by pressing 

 on the main toolbar of the programme. 
If the user needs to enter or edit parameters of the measured spectrum after the measurement 

has ended, this should be done in the Spectrum parameters window (see Fig. 20), which can be 

opened by pressing  on the toolbar of the spectrum window. Changes in parameters of any 
reopened spectrum are made in the same way. 

 

 
Figure 20. Spectrum parameters window view 

 
The parameters window can be pinned to the frame of the spectrum. To do this, double click 

on the window heading, then a window will move to the right side of the spectrum window. 
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4 Work with a spectrum 
4.1 Main functions  
 
To open a spectrum, click menu item File->Open spectrum. The standard *.asw file format 

will be suggested by default. However, the software is able to open and edit files of other types. To 
change the type of a spectrum loaded, select the desired file type in the dropdown list of field File of 
type in the standard dialogue window (see Fig. 20.1). 
 

 
 

Figure 20.1 Choosing a spectrum type in the standard loading window 
 

 Once a spectrum (spectra) is selected, the software displays spectrum window(s) as shown in 
Fig. 21. Now, the spectrum (spectra) can be processed. 

 
Work with a spectrum may include different tasks, for example, studying the obtained 

energy distribution, spectrum zooming, processing of individual peaks, printing of a spectrum, 
energy calibration and so on. 

 

 
Figure 21. Spectrum window view 

Figure 21 displays main elements of the spectrum window. 
 
The status bar displays live, real time values in seconds for this spectrum, as well as dead 

time in percent.  
The Intens. field of the status bar displays the aggregate value of intensity across the 

spectrum, i.e. the integral value of the entire spectrum divided by live time. 

Toolbar 

Marker 

Peak marker 

Current  
selected 

peak 

Status bars 
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If a calibration ADER (ambient dose equivalent rate) file has been uploaded, the last field of 
the upper status bar will display the ADER value.  

The second status bar displays values of the marker position in channels and energy units. 
The Count field displays the count value in the spectrum corresponding to this channel. 

 
The main spectrum working mode, when the mouse cursor looks standard (white arrow), 

provides the possibility to zoom the spectrum and to drag (move) it on both axes. To zoom a 
spectrum region (i.e. stretch), set a marker in the left position of the region, press and hold the left 
mouse button moving it all the way to the right. In the process of dragging, a grey transparent 
rectangle showing the boundaries of the selected region will appear. A block of information with 
data of the range boundaries, area and intensity in this range will appear near the region selection. 
When selected, release the mouse button, and the spectrum will be stretched to the width of the 

selected region. To return to the previous zoom level, press  on the spectrum toolbar. To return 
to the initial zoom level (to the full range of the spectrum), double click anywhere in the spectrum. 

If you need to move the spectrum left or right along the horizontal axis, press the right 
mouse button and hold it while moving the cursor in the desired direction.  The spectrum will move.  

 
The spectrum toolbar contains the following buttons: 
 

 - a button for displaying spectrum parameters as shown on Figure 20. 

 - a button for saving spectrum data and parameters to a disk. When you press this button, 
any discovered peaks and their parameters are also saved to a disk. These data are stored in the file 
with the same name as that of the spectrum, but have an *.asr extension, and the location of this file 
is the same as that of the spectrum. 

 - a button for opening the energy calibration window for this spectrum (see section 7). 

 - a button for opening the FWHM and shape calibration window for this spectrum (see 
section 8). 

 - a button for enabling the mode for work with a peak. Thanks to this mode, the user has 
the possibility to study any peak or multiplet in detail, as well as adjust the peak with describing 
functions. When you press this button, it gets fixed and the cursor moving around the spectrum field 
looks like two closed brackets '[]'. 

To select a spectrum region, which will be moved to a separate window for work with the 
peak, set a marker to the left position of region, press and hold the left mouse button moving it all 
the way to the right (Fig.22). In the process of dragging, a dark transparent rectangle showing the 
boundaries of the selected region will appear. Then release the mouse button and an additional 
window with the selected region will appear on the display (see Fig.23). 
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Figure 22 

 
 

 
Figure 23. Window for work with a peak view 

 

 - a button displaying a menu with spectrum options. When you press this button, a menu 
shown on Figure 24 will appear. 
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   Figure 24. Menu Options of the spectrum window 
 
Items in this menu are mainly intended for service and have the following functions: 
Results – opens a panel of measurement results.  
Add to log – sends measurement results to a log. 
Send to pack – opens this spectrum in the Pack of spectra window. 
Panorama window - when opened, this window (see Fig. 24.1) displays that part of a 

spectrum which is marked by scaling in the main spectrum window. The semi-transparent rectangle 
can be moved by user which automatically changes  the scaling in the main spectrum window. The 
opposite is also true: changing the scale and zooming the spectrum’s regions is automatically 
displayed in the Panorama window. 

 

 
Figure 24.1. The Panorama window of a spectrum. 

 
Logarithm  – enables a logarithmic scale for spectrum display. 
Show background – shows the background spectrum. 
Hide spectrum – hides the spectrum. 
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Spectrum without bkg – shows the spectrum without spectrum background. 
Intensity – switches the vertical axis from the count in impulses to intensity in imp/sec. 
Energy range – switches the horizontal axis from the channel scale to the energy scale. 
Show ROI – shows regions of interest (ROI) contained in the calibration file (*.clb) for the 

ROI-method. 
Offer a nuclide – a tool aiding in identification of radionuclides, which highlights regions of 

the spectrum, where peaks for the radionuclide selected from the list should be present (see section 
4.4). 

Report – generates a protocol for printing of a spectrum. 
Autocalibration by source (Cs-137, Co-60, Eu-152, Th-228) – a tool allowing to perform 

automatic calibration by energy, FWHM and shape of a spectrum with radionuclides most used in 
spectrometry.  The procedure may last several seconds. At the end of autocalibration, the 
programme will display a message with the results and enter the received values in the spectrum 
calibration. 

Send to (Word, Excel, Matlab) – converts the spectrum to MS Word, MS Excel and 
Matlab, respectively. 

 

The  group of buttons is intended for searching peaks, as well as 
calculating activities using the peaks analysis method (see section 6). 

 
4.2 Work with a peak  
In the peak mode, a window as shown on Figure 23 appears on the display after selecting a 

spectrum region. 
This window has a toolbar with buttons allowing to perform mathematical modelling for the 

purposes of describing peaks by dependencies, or, in other words, to introduce Gaussian curves (or 
other functions) in the selected spectrum region. 

 

The  (Gaussian) button is intended for introduction of the Gaussian curve in the region 
of the Peak window. The programme determines automatically the centroid of the peak and 
calculates all the parameters related to this peak. Peak processing results are displayed in a window 
as shown on Fig. 25. 

 

 
 

Figure 25. View of the Peak list window with peak processing results 
 
In the table on Fig.25, the last column contains two buttons allowing to send the results 

received about this peak to energy calibration (En…) and to FWHM and shape calibration 
(FWHM ).  

 

The  (Multiplet ) button is intended for introduction of Gaussian curves in the region of 
the Peak window for multiplets (several merged or unresolved peaks). To conduct such a 
processing, the user should put markers in approximate positions, where the peak centroid can be 
found. Such function allows describing a multiplet containing no more than 3 peaks. Put markers 

with a double click in the centroid region. Then press  and a calculation will be performed. The 
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result will be displayed in a window similar to that displayed on Fig.25. In case of incorrect 

modelling of the describing curve, the user should reset markers and the plotted graph with , 
mark then once again. 

The  (Multiplet with high resolution ) button has the same intention as , however, it 
is more fit for describing peaks with high resolution (for example, peaks received on extra-pure 
Germanium spectrometers, etc.). The function describing each peak has two parts – the Gaussian 
part and the so-called left exponential edge. The distance in channels from the centroid to the left, 
where the exponential part starts is the 'Left edge' (see Fig.25). 

For a better adjustment, by pressing  again, you can improve adjustment of the describing 
curve to experimental values. 

 

To perform processing, you should do preliminary marking and press the  marker. The 
processing result looks as shown on Fig.26. 

The  (Add peaks to peak list of spectrum) button on the toolbar in the Peak window is 
intended for adding processed peaks to the spectrum results table. If the peak’s area is smaller than 
the threshold area (specified in the Min. area parameter), then the peak addition command will be 
ignored. 

 
 

Figure 26. Peak and Peak list window view 
 
The context menu, which pops up, when you right click on the graph in the Peak window, 

has the same buttons as the toolbar, and also: 
Energy range – switching between channel and energy scale; 
Logarithm  – switching between linear and logarithmic scale; 
To printer  – printing of the graph in the Peak window. 
 
4.3 Material window 
 
The Material field in the Spectrum parameters window is intended for specifying the type 

of substance to be measured or its category for the programme. When you press  at the edge of 
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the field, a window opens (see Fig. 27), which allows managing the files containing information 
about values of Permission Level (PL). The file with the data on PL has a *.mat extension. 

 buttons on the toolbar of the Material  window allow editing the table of 

materials (to add/delete a material or a radionuclide).  buttons are for saving the edited table 
or loading a table saved to a disk. 

 
Figure 27. Material  window 

 
4.4 Prompt window 

 
Using the Offer a nuclide command in the Options menu (see section 4.1, Fig.24) in the 

measured spectrum with distinct peaks, you can visually identify nuclides from the set library of 
nuclides librp.dat.  When you activate the Offer a nuclide menu item, a Prompt window, which 
will display the list of radionuclides, will appear on the display (see Fig.28). 

 

 
Figure 28 
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To select items, press on the row with the name of the expected radionuclide with a mouse 

button. Areas in the spectrum in the region of lines of the respective nuclide are highlighted in 
white, and are marked with the value of quantum yield for this line. 

 

5 Determining activities of radionuclides by the ROI-method 
 
5.1 Calculation by one spectrum 
 
Sequence of calculation of specific activities of radionuclides 
Load a working spectrum (File->Open spectrum). 

Open the spectrum parameter window by pressing . 
Load a spectrum background in the Background field and the necessary calibration file 

(*.clb) in the Calibration  field. 

Then, press the right part of the  button to open a menu offering variants of 
calculation types (see Fig.29). 

 
 

Figure 29. Variants of calculation types 
 
For this task (calculation of activity by one spectrum using the ROI-method) select 

Calculation (ROI-method) 

  
Figure 30.  Results window view  

Toolbar of the 
results table 

 



 26

A table with measurement results will appear at the bottom of the spectrum window or in a 
separate window. This table contains columns for 'Nuclide' , 'Activity ’, relative error of spectrum 
shape selection 'Ac.error,% ', as well as columns for specific activity, absolute and relative errors in 
their determination. If the Material  field (in the spectrum parameters window) contains instructions 
about the type of substance to be measured, two more columns PL (permission level) and FC (factor 
of conformity) will appear in the results table. 

It should be noted that the 'Activity'  column contains values corresponding to the 
countable sample, but 'Sp.activity' (column 4) – those corresponding to the sample. Thus, the 
coefficient of concentration is taken into account, when calculating specific activity (and so on in 
column 4). 
 If relative error in the calculation of activity exceeds 50%, then the MDA (minimum detected 
activity) value is displayed in the 'Activity ' field instead of the activity value. 
 
  The panel with calculation results should not necessarily be within the spectrum window. It 
can be 'separated' from the left edge of the spectrum by double clicking on the heading of the 
Calculation results panel, or you can drag the panel holding its heading. To return the panel to the 
spectrum window, double click on the heading of the Calculation results window with the left 
mouse button. 
 

Rows under the table show the value of effective specific activity of natural nuclides Aeff, the 
consolidated factor of conformity, names of the calibration file, background file and work spectrum 
used, the date as at which the activity has been calculated, as well as weight and volume of the 
countable sample, if it was taken into account. 

After the comment, there is a block by regions of interest, if the spectrum parameters include 
an indication that it should be calculated and displayed. 

If you want to save the results table, there is a toolbar above it containing buttons allowing to 

convert data in different ways ( - saving data to a txt protocol;  - sending data to MS Word;  
- generating a report;  - sending data to a DB. 

 
To save data to a protocol, write its file name in the Protocol filename field of the 

Parameters window (Options->Parameters->Files tab). The data will be sent to the end of the set 
text file. 

To be able to send data to MS Word, MS Word should be installed in your Windows 
operating system. 

 
When a report is generated ( button), a window is displayed, where the preview block 

displays the table of activities and the block of comments (see Fig.31). You can add title information 
to the page. This option requires a printer installed in the Windows operating system. 
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Figure 31.  Report generation window view 
 

After changes have been made (title editing, disabling/enabling fields), press Update. There 
is a Print  button for printing the page shown in the right part of the window (the so-called preview 

block). To send the page to MS Word, press . To save the page in the *.rtf format, press Save. 
When you press  on the toolbar in the results table, the Database record window will 

appear, where you can enter additional data not saved in the spectrum (Fig.32). 
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Figure 32. Database record window view 

 
The window on Figure 32 is divided into two tables of fields. The left one, which cannot be 

edited, contains already known data about the spectrum, but the right one, which can be edited, 
contains fields for entering missing information. After you have filled the fields, make sure that the 
Database filename field contains the name of the database and press the Add button. If the transfer 
has been successful, you will see a relevant message. 

 
5.2 Common calculation by sample number 
 
According to the requirements of regulatory documents, the results of measurements of 

specific activities received in different spectrometric tracts, as well as the consolidated factor of 
conformity of the sample being measured, should be shown in a single protocol of measurement. To 

fulfil this requirement, use Common calculation in the menu of the  Calculation button (see 
Fig.29). 

For a correct calculation: 
- open spectra of one sample measured in different spectrometric tracts (for example, on a 

beta and gamma detector); 
- make sure that the Sample ID field (see Spectrum parameters window) displays the same 

identifier for all the spectra; 
- conduct a separate calculation for each spectrum (see section 5.1); 

- for one of the spectra you can select Common calculation in the menu of the  
Calculation button. 

When you have received the results table, make sure that there is a note about the common 
calculation (Fig.33), as well as confirm adequacy of the received results. 

If there is specific activity calculated in different spectra, its result is averaged taking into 
account the calculated error.  

If there is specific activity calculated in one spectrum (error less than 50%), and only 
assessments (equal to MDA) in the other spectrum, only the data containing specific activity are 
used in averaging. 
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If assessments only (equal to MDA) are available in all the spectra, the smallest of these 
assessments is displayed as the result for this radionuclide. 

 
 

 
 Figure 33.  View of the table of the result of common calculation by sample number 

 
5.3 Shared beta – gamma calculation 
 
In cases, when sample measurement is made on a gamma and beta detector, in order to 

increase accuracy, it is sometimes necessary to consider the results determined in one of 
spectrometric tracts in calculations of the other one. Thus, for example, when performing 
measurements in a beta tract taking into account activity 137Cs and 40

К in the gamma tract, minimum 
detected activity 90Sr can be reduced. 

For a correct share beta-gamma calculation: 
- open spectra of one sample measured in different spectrometric tracts (on a beta and 

gamma detector); 
- make sure that the Sample ID field (see Spectrum parameters window) displays the same 

identifier for both spectra; 
- conduct a separate calculation for the gamma spectrum (see section 5.1); 
- for the spectrum of the beta detector you can select Shared calculation BG in the menu of 

the  Calculation button. 
When you have received the results table, make sure that there is a note about the shared 

beta-gamma calculation (Fig.34), as well as confirm adequacy of the received results. 
 
 

Note about 
common 

calculation 
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Figure 34.  View of the table of the result of shared beta-gamma calculation 

 
 
5.4 Superposition method 

 
 The calculation of activity using the superposition method serves as some kind of control of 
measurements. After a countable sample has been measured and the calculation has been conducted, 
the accuracy of calculation of activities may be controlled in the Superposition window by 

selecting the Calculation by superposition method in the menu of the  Calculation button. 
 

  

Figure 35. Superposition window view 

 If the calculation has already been performed, the programme displays (Fig,35, block 1) the 
measured (red) and the estimated (green) spectrum, as well as estimated values of activities of 
radionuclides (Fig.35, block 2). If the measured and the estimated spectra match, this confirms that 
the list of radionuclides and their activities match the radionuclide activity of the countable sample. 

Note about the 
share beta-

gamma 
calculation 

 

Block 1 

Block 2 

Block 
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Through visual evaluation of matching of spectra the user may adjust estimated values until 
the spectra fully match. If full match is still impossible, it may be assumed that the countable sample 
contains other radionuclides in the countable sample or there is inaccuracy in energy graduation. 

The  button is used for selection of a library spectra list file (*.lcs), which is necessary 
for the calculations. This file is generated at the calibration stage for each measurement geometry 
(see Paragraph14.2) and is supplied in the installation package of the spectrometer.  

The  button is intended for updating the calculation after uploading a new library spectra 
list file.  

The Log checkbox shown on Fig.35 (block 3) provides the possibility to change the scale of 
the graph of spectra to logarithmic. The Bkg checkbox brings the current background spectrum to 
the graph. The R/n checkbox allows displaying on the graph spectra of mononuclides participating 
in plotting of the common spectrum (green).  

The status bar of the Superposition window displays information about the currently loaded 
library spectra list file, the number of these spectra and the number of radionuclides. 
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6 Determining activities of radionuclides by the individual peaks analysis 
method 

 
6.1 General statements 

 
The principle of determining activities of radionuclides using the individual peaks analysis 

method is the possibility to search for peaks automatically, describe each of them using the Gaussian 
curve (with protracted left exponential edge), further calculate the area and, finally, calculate 
activities by each identified radionuclide. The ability to identify is conditioned by the possibility to 
connect to the spectrum a radionuclides library file, which contains reference data on characteristic 
energy lines, values of their quantum yield, etc. So, if there is a spectrum of a countable sample, a 
library file (*.lbr,*.bib ) and an efficiency file (*.efp), the user may calculate activities of 
radionuclides. 
 
 For the method to work accurately, the user must fill in fields in the Spectrum parameters 
window with relevant values. Main parameters determining the work of the method being described 
are concentrated in the right table of parameters (see Fig. 36) in Search Peaks, Smoothing, 
Identification  groups. 

 
Figure 36 

  
 The Search peaks group contains the following parameters: 
 L.limit , R.limit  – range values in channels, where the search of peaks will be performed. 
Peaks will not be searched for and identified outside this range. 
 Level – the limit value of the parameter related to the statistical importance of peaks, above 
which the found peak is accepted and added to the table, and below which the peak is rejected, 
usually assumed as being equal to 3. 
 Min.area – the limit value of the peak area in impulses. The peaks with the value above this 
one are accepted and added to the table, and below this value are rejected. 
 Type search – one of two possible types of search for peaks in the spectrum ('Search and 
Identification', 'Peaks from library' ). So, the 'Search and Identification' type searches for all the 
peaks available in the spectrum and meeting the criteria of the Search peaks section. The 'Peaks 
from library'  type envisages application of preliminary markings according to the loaded 
radionuclides library file (see the Library file  field in the Identification  section). If the user faces 
the task of determining the activity of certain radionuclides only, 'Peaks from library'  should be 
used. 

Main parameters 
for the 

calculation using 
the individual 
peaks analysis 

method 
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 Show peaks – parameter for enabling displaying of peaks and their parameters in the 
spectrum. 
 The Smoothing  parameters control polynomial smoothing of a spectrum relevant for a 
better peak search and description of peaks by functions. The Smoothing parameters include: 

Polynomial degree.  This parameter defines the degree of the polynomial smoothing to be 
considered for spectrum peak search. The parameter’s value should not exceed 6, and the 
recommended value is 5. 

Iteration . This parameter defines the number of smoothing iterations for spectrum peak 
search. If this value is 0, no smoothing will be performed. Spectra featuring high statistics should 
not be smoothed, and the parameter’s value for such spectra should remain 0. 
 The Identification group contains parameters participating in the identification of the peaks 
found in the spectrum. 
 Library file  – path to the radionuclides library file, which will correspond to the measured 
spectrum. The library file contains a list of radionuclides, their energy values, probability of outputs 
and half-lives. Library files are generated using the Library editor  dialogue window (see section 
12) and are used in the process of calculation of the activity using the peaks analysis method. 
 Efficiency file – path to the efficiency calibration file, which will correspond to the 
measured spectrum. The efficiency calibration file contains a dependence of the efficiency of 
registration on gamma-quantum energy and is used in the process of calculation of activity using the 
peaks analysis method. The efficiency file is generated using the Efficiency calibration dialogue 
window (see section 9). 
 Passport of source – a link to the file containing parameters of the source of calibration. The 
file must contain the list of radionuclides present in the source, description of their geometry, mass, 
volume, activity and the date of its adjustment. The passport of source file is generated in the Editor 
of source passports dialogue window, which can be opened from the main programme menu 
Options->Editor of source passports. It should be noted that the passport of source file should be 
specified only during calibration (i.e. to create the efficiency file). To perform calculations for the 
purposes of determining activities, this field should be left blank. 
 MTP . This parameter is the so called peak thickness factor, or, in other words, the distance 
at which two peaks are indistinguishable. The value of this parameter is set in arbitrary units in the 
range between 3 and 10. In case two peaks close to each other are processed separately as if they 
were singlets (i.e, each peak has its own background substrate) but they are supposed to be 
processed together (I,e., so that they have a common background substrate), the calculation should 
consider this parameter and be repeated until the peaks are processed together as a multiplet. 
 Allowable dev., keV – the energy deviation parameter, within which a peak may be assigned 
to a characteristic curve of some radionuclide 
  
 In the realisation of the individual peaks analysis method, calibration of the spectrometric 
tract (or the spectrum) by peak energy, FWHM and shape becomes special. Therefore, before 
performing the calculation, make sure that the respective calibrations have been made (see sections 
7, 8). 

 
6.2 Procedure of calculation of activities by the individual peaks analysis method 
 
6.2.1 Measure the spectrum of the countable sample or load an available spectrum using the 

main programme menu File->Open spectrum. 



 34

6.2.2 Information about the source may be entered before, during and after the measurement. 
In the first and second case, parameters are specified in the fields of Measurement parameters and 
Calculation parameters windows. 

6.2.3 If parameters of any measured spectrum need to be changed, the Spectrum 
parameters window should be used (see Fig. 36)  

6.2.4 Depending on the task, specify one of search types ('Search and Identification', 
'Peaks from library')  in the Type search field (Fig.36). 

6.2.4 Among the fields of the Spectrum parameters window, which should be completed, 
there is an Efficiency file field. You should enter the name of the calibration efficiency file there (  
button). The operator selects the efficiency file according to the type of the countable sample and 
parameters of geometry of measurement and enters it into the programme using a standard file 
selection dialogue window.  

6.2.5 In the Library file  field in the Spectrum parameterswindow, specify the name of the 
radionuclides library file, which contains data about energy lines and other information about 
radionuclides, which are presumably contained in the sample being measured.  

6.2.6 Then, select the Calculation by peak analysis method in the menu of the  
Calculation button (see Fig.29). Then, a panel with results of measurements with the Peak analysis 
tab selected will appear at the bottom of the window. As it was mentioned in p.5.1, the panel with 
measurement results can be separated from the spectrum frame. 

6.2.7. On the Library  tab of the table, check those radionuclides, the activity of which the 
user intends to determine.  This tab displays data contained in the library file specified in the 
spectrum parameters window (Library file  field). 

  

Figure 37. Library  tab view  

 

6.2.8 On the toolbar of the spectrum window (Fig.38, block 1), press  (New search peak 
and calculation). If the spectrum has correct calibration by energy, FWHM and shape of the 
spectrum, the Peak analysis tab of the measurement results panel will display information on any 
discovered peaks (Fig.38, block 3). Also, found highlighted peaks with titles will appear on the 
spectrum graph (see Fig.38, block 2). 
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Figure 38. Spectrum window view after peak search 

 
The results panel, under the table with Found peaks, has another table Result by 

radionuclides, which contains estimated values of activities of radionuclides. 
The Found peaks table has the following fields: 
'Number'  – number in sequence of the found peak; 
'Channel' – position of peak centroid in channels; 
'Energy'  – energy value, keV; 
'Line'  – characteristic energy lines of gamma radiation for the specified radionuclide; 
'Area'  – peak area in channels; 
'Intensity'  – peak intensity in imp/sec; 
'Activity, Bq'  – radionuclide activity value determined only for this line; 
'Stand.uncert.,%'  – standard relative uncertainty of activity calculation for this line; 
'Benchmark'  – sign of acceptance of this line as a benchmark. Used for the purposes of 

improving splitting of merged multiplets into components. 
 
The Result by radionuclides table contains the following fields: 
Nuclide – name of the radionuclide, on which this row contains information; 
Activity, Bq  – weighted average activity in Bq received by averaging activities from the 

Found peaks table considering the uncertainly for each line. If relative expanded uncertainly in the 
calculation of activity exceeds 50%, then the MDA (minimum detected activity) value is displayed 
in this field instead of the activity value. 

Sp.activity, Bq/kg – specific activity in Bg/kg (parameter depending on the calculation 
type); 

Block 1 Block 2 

Block 

Block 

Block 
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Exp., uncert.% – expanded uncertainly of the result of measurement with coverage factor 
k=2. 

The Result by radionuclides table, which is being described, may contain two columns PL 
(permission level) and FC (factor of conformity), which were described in section 5.1. 

In the Result by radionuclides table, for each radionuclide, for which activity has been 
calculated, you can see lines, on which this activity was calculated. To do this, you should press on 
the  icon located in front of the name of the radionuclide. 

6.2.9 Visually analyse adequacy of the plotted mathematical model for each found peak, i.e. 
evaluate the quality and correctness of description of the Gaussian curve peak. If the peak 
description is unsatisfactory, it should be deleted or adjusted (see section 19.1). For the purposes of 
such a visual analysis, for fast zooming of the peak according to the size of the spectrum window, 

double click on the peak title with the left mouse button, or press  to return to normal zoom. 
6.2.10 Then, the result of determining of activities may be converted to a protocol, MS 

Word, report or database. For these purposes, there is a toolbar similar to that described in section 

5.1 and located above the Found Peaks table (  - saving data to a txt protocol;  - sending data 
to MS Word;  - generating a report;  - sending data to a DB). 

6.2.11 To save the found peaks and all the other parameters entered in the Spectrum 
parameters window, press . After that, when you open this spectrum, marking with found peaks 
will be done automatically. The list of peaks and their parameters are saved in the file having the 
same name as the spectrum, but with an *.asr extension. 

 
To consider background in the calculation of activities, it is necessary to link it in the 

Background field in the Spectrum parameters window. The spectrum background should be 
measured with good statistics, as well as processed similarly to the work spectrum. The table of 
found and identified peaks of the background spectrum is saved automatically together with the 
spectrum in the same way. The programme loads the table of background peaks, when opening the 
work spectrum or when the background spectrum in the work spectrum changes. 

 
6.3 Adjustment of found peaks   
Peaks can be searched in two modes 'Search and Identification' and 'Peaks from library' . 

In the first case, the search is made according to the parameters specified in spectrum parameters 
(search range, smoothing, etc.), and all the peaks meeting these requirements are recorded. In the 
second case, only those peaks are highlighted, which match the energy lines specified on the 
Library  tab. 

 As shown in section 6.2, when you press , a new search for peaks is performed. To adjust 

found peaks in order to recalculate their peak area and also activity, use  (Update calculation for 
found peaks), which is also located on the toolbar of the spectrum window. It is used, if the position 
of peaks is correct, but the description of their curve is incorrect, or when adjustment by the 
benchmark peak is used.  

As peaks are identified automatically, some peaks may be recognised incorrectly, therefore, 
the identification result may be adjusted manually in the 'Line' column of the table using the 
dropdown list with energy lines getting in the energy limit (see Spectrum parameters window). 

If spectra are complex, you can use curve description adjustment of some peaks by 
benchmark. If the radionuclide has several peaks and one singlet, the latter may be taken as a 
benchmark by checking 'Benchmark'  in the table. Then, having loaded the efficiency file, you can 

make a recalculation by pressing  on the toolbar. For the other peaks (which are not benchmarks), 
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their estimated height for further processing will be calculated. Thus, the credibility of splitting of 
multiplets into components will increase. 

6.4 Inserting and deleting peaks 
The toolbar of the spectrum window contains a group of three buttons as shown on Figure 39 

(in a frame). 
 

 
 

Figure 39. Identification  button group view 

 Thus, the  (Insert peak mode) button is intended for toggling to the insert peak mode. 
In this mode, the mouse cursor becomes a green down arrow (see Fig.40.1). To insert a found peak 
to the specified position, set a marker in the peak centroid region and double click with the left 
mouse button, then the peak will be highlighted and added to the table of found peaks (see Fig. 40.2, 
block 3). For insertion, you can use double click or press the Insert key on the keyboard. 
  

 
Figure 40.1. Preparation of a marker for peak insertion 
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Figure 40.2. New inserted peak 

  

 
Figure 40.3 

 A found and described peak in the spectrum has a Gaussian curve outline as shown on Figure 
40.3. There is a peak title near the Gaussian curve describing the peak (see Fig.40.2, block 1, and 
Fig.40.3). If the peak has been identified, the title contains peak energy and the name of the 
radionuclide.  
 When hovering a cursor over the peak title, a popup prompt appears (see Fig.40.2, block 2) 
containing peak parameters, such as channel, energy, radionuclide name, FWHM, resolution, area 
and intensity. Once the cursor is at the 1332.5 keV peak’s title, there appears a pop-up hint which 
displays the Peak-to-Compton ratio. For the 5.9 keV peak, the Peak-to-Background ratio will be 
shown. 
 To select a peak, left click on its title. If you double click on the title, this peak will stretch 
according to the length of the spectrum.  
 If you right click on the title, a popup menu will appear as shown on Figure 40.4. 
 

Block 1 
Block 2 

Block 3 
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Figure 40.4 

 
 In this menu, Show peak in separate window selects this peak and opens it in the Peak 
window (see section 4.2). 
 Send to energy calibration and Send to FWHM and shape calibration make it possible 
for the user to add data of the peak being viewed to energy calibration and FWHM and shape 
calibration. 
 

 The  (Delete peak) button of the toolbar of the spectrum window is intended for the 
deletion of a peak from the list of found peaks.  

 The procedure of deletion of a peak is as follows. Exit the insert peak mode by pressing  
again, so that the cursor returns to its standard view.  Then select a peak to delete. To do this, you 
can use peak selection in the table by selecting the peak you need. You can also select a peak by left 
clicking on the peak title. In either case, the peak will have a bold green outline and the row 

corresponding to it will get selected in the table. When a peak has been selected, press  on the 
toolbar of the spectrum menu.  

 If you want to delete all the found peaks, there is a  (Delete all) button. 
 

6.5 Sending of a list of peaks to calibration 
  

 The toolbar above the table of Found Peaks contains additional buttons  (see Fig.38, 
block 5).  These buttons are intended for sending of data about found peaks to peak FWHM and 
shape calibration. It should be noted that even though the information about the FWHM and shape 
value is not available in the Found Peaks table, this information is stored in the programme and 
may be sent to dialogue windows generating FWHM and shape calibrations. 
 To send data to calibration, in the tables of found peaks select those peaks, which you want 
to convert (see Fig.41), and press  (Send selected peaks to energy calibration) or  (Send 
selected peaks to FWHM and shape calibration), depending on the target calibration. 
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Figure 41. Selection of peaks for sending to calibration 

 
 When you press these buttons, a dialogue window of the relevant calibration will open. 

 

7 Energy calibration 
 

Before identification, it is necessary to match the energy value with the analyser’s channel 
number, i.e. perform energy calibration of the spectrometer. Spectra of standard sources of γ 
radiation are entered for this purpose. The spectrum, which participates in energy calibration, must 
contain several well-shaped peaks. The procedure should be periodically repeated depending on the 
stability of operation of the source of high voltage, amplifier and analyser. 

For energy calibration of a selected spectrometric tract, select this tract on the Device 

manager panel.  Then, press  and a dialogue windows will appear on the display as shown on 
Figure 42. 

 

Figure 42. Energy calibration window 

 On the left side of the window, there is a table (Fig.42, block 1) containing three columns 
'Channel', 'Energy (library)' , 'Energy (calc.)'. The table contains information about lines (peaks), 
which are the basis for energy calibration.  
 Thus, Fig.42 shows calibration consisting of two points, which describes the dependence of 
energy on channel in the spectrum. To calculate functional dependence, the user should press the 

Block 1 

Block 2 

Block 3 
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Calc calibration button (Fig.42, block 3), and the received formula will be displayed in the Result 
field. Also, after the calculation, the graph (Fig.42, block 3) will show the found dependence. 
 If there are more than two points in the table, the programme may determine the parameter of 
integral nonlinearity (INL), which is displayed in the INL  field in block 3. Also, in this case a 
polynomial dependence of second degree can be built. To do this, set the value of 2 in the 
Polynomial degree field. 
 The user may add and remove points from the table. To do this, use  (Add item) and  
(Delete item), which are located above the table. Thus, if you press , a new row will appear in the 
table, which the user should fill with values of the field in the 'Channel' and 'Energy (library)'  
columns.  
 If you want to start generating a new calibration, there is a  (Delete all) button located 
above the table. When you press this button, the table will keep two rows, which are minimally 
necessary for plotting a straight-line correlation. You can edit the table by editing fields in these 
rows. 
 Data can be brought to the table in several ways: 
 - from the table of found peaks in a processed spectrum (section 6.5, Fig.41); 
 - from the window for work with peak (section 4.2, Fig,25); 
 - from the peak title context menu (section 6.4, Fig. 40.4). 
 
 
 To get a prompt of the library energy value in the field of the 'Energy (library)'  column, in 
the editing mode there is a possibility to open a library window (see Fig.43.1). This function is 
available, if a library file is specified in the Library file  field.  
To open the library window, press  at the right edge of the field.  
 

 
Figure 43.1  

 
 Then, a window for selection of an energy line from the library will appear on the display 
(Fig.43.2). 
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Figure 43.2 Window of energy selection from the library 
 
 The user may select a radionuclide and a line from the list provided in the left table. When 
you double click on the selected energy, the library window will close and the energy value will be 
populated in the table field of the Energy calibration window. 
 You can also use library search. For this, in the Energy, kev field in the right portion of the 
Radionuclide library  window, specify an approximate energy value, which should be found in the 
library and having specified the range of search in the next field, press Search. As a result, the right 
table will display lines corresponding to the set condition. The user may select the required variant 
from the list by double clicking on the respective row with the left mouse button. 
 
 When you have received the searched functional dependence for energy calibration, it should 
be applied to the current spectrometric tract. To do that, press Apply  at the bottom of the Energy 
calibration  window.  
 To save to a file and load all the calibration data, use Save and Open, respectively. 
 The Energy calibration window allows the user to generate a text report to receive and print 
summary information. For this purpose, there is a Report button in the bottom part of the window. 
When the calibration is over and you press this button, the window shown on Fig.44 will appear. 
 

      

 To print a report, press . 
 To perform energy calibration for the specific work spectrum, open this spectrum and press 

 on the toolbar of the spectrum window, and then a dialogue window similar to that shown on 
Figure 42 will appear. The only difference will be the availability of an additional button Apply to 
tract  at the bottom of the Energy calibration window. This button is intended for the applicable of 
the new calculated calibration to the spectrometric tract, which corresponds to the spectrum being 
viewed.  

8 FWHM and shape calibration 
 
 FWHM (full width at half maximum) calibration is a procedure of searching functional 
dependence of the FWHM parameter on the channel in the spectrum.  
 The term ‘peak shape calibration’ in GammaPRO is defined as a search for dependence of T 
parameter (the so-called ‘left edge’) on the peak centroid channel in the spectrum. T parameter is the 

Figure 44. Energy 
calibration report view 
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distance in channels from the peak centroid to the left, after which the peak is described with 
exponential dependence rather than Gauss (see Fig.45). 
 

 

Figure 45. Shape of the graph describing a peak 

 
For FWHM and shape calibration of a selected spectrometric tract, select this tract on the 

Device manager panel.  Then, press  and a dialogue windows will appear on the display as 
shown on Figure 46. 

  

Figure 46. FWHM and shape calibration window 

 On the left side of the window, there is a table (Fig.46, block 1) containing three columns 
'Channel', 'FWHM' , 'Left edge (shape)'. The table contains information about lines (peaks), which 
are the basis for FWHM and shape calibration.  
 Thus, Fig.46 shows calibration consisting of a certain number of points, which describe the 
dependence of FWHM and shape on channel in the spectrum. To calculate functional dependences, 
the user should press Calc calibration (Fig.46, block 3), and the received formula will be displayed 
in the Result for FWHM  and Result for shape fields. Also, after the calculation, the graph (Fig.46, 
block 3) will show the found dependences. 

Block 1 

Block 2 

Block 3 
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 If there are more than two points in the table, polynomial dependences of second degree can 
be built. To do this, set the value of 2 in the Polynomial degree for FWHM and Polynomial 
degree for shape fields. 
 The user may add and remove points from the table. To do this, use  (Add item) and  
(Delete item), which are located above the table. Thus, if you press , a new row will appear in the 
table, which the user should fill with values of the field in the 'Channel', 'FWHM' and 'Left edge 
(shape)' columns.  
 If you want to start generating a new calibration, there is a  (Delete all) button located 
above the table. When you press this button, the table will keep two rows, which are minimally 
necessary for plotting a straight-line correlation. You can edit the table by editing fields in these 
rows. 
 Data can be brought to the table in several ways: 
 - from the table of found peaks in a processed spectrum (section 6.5, Fig.41); 
 - from the window for work with peak (section 4.2, Fig,25); 
 - from the peak title context menu (section 6.4, Fig. 40.4). 
 When you have received the searched functional dependences for FWHM and shape 
calibration, they should be applied to the current spectrometric tract. To do that, press Apply  at the 
bottom of the FWHM and shape calibration window.  
 To save to a file and load all the calibration data, use Save and Open, respectively. 
 The FWHM and shape calibration window allows the user to generate a text report to 
receive and print summary information. For this purpose, there is a Report button in the bottom part 
of the window. When the calibration is over and you press this button, the window shown on Fig.47 
will appear. 
 

 
Figure 47. FWHM and shape calibration report view 
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To print a report, press . 

To perform FWHM and shape calibration for the specific work spectrum, open this spectrum 

and press  on the toolbar of the spectrum window, and then a dialogue window similar to that 
shown on Figure 46 will appear. The only difference will be the availability of an additional button 
Apply to tract  at the bottom of the FWHM and shape calibration window. This button is intended 
for the applicable of the new calculated calibration to the spectrometric tract, which corresponds to 
the spectrum being viewed.  

9 Efficiency calibration 
 

9.1 General statements  
 
The calibration of a spectrometer by registration efficiency is performed using the activity 

measures reproducing the geometry and properties of gamma-ray absorption of the countable 
sample.  

As a result of calibration, energy dependence of registration efficiency in peaks of complete 
absorption of gamma quanta radiated by sample (reference) measures is determined. When it is 
necessary to take into account absorption of gamma-quanta in the material of a bulk spectrometric 
preparation, energy dependences of registration of gamma-quanta are determined using several sets 
of reference bulk measures with different density of filler materials. 

The calibration process is conditionally broken down into four stages: 
− measurement of spectra of sample activity measures or receiving these spectra via calculations 

using a specialised programme, which simulates interaction of radiation with the substance; 
− processing of spectra for the purposes of searching, identification and determining areas of 

peaks; 
− calculation of efficiency of registration of gamma-quanta based on gathered spectra of the set of 

sample measures and approximation of energy dependences of efficiency of registration of 
gamma-quanta; 

− creation and saving of an *.efp calibration file. 
 

The dependence of efficiency of registration of εn on energy of gamma-quanta En is 
described by functional dependence 9.1: 
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where Ai are polynomic coefficients determined in the process of calibration, i=0..6. 
 
Annex 2 shows an *.efp file format. 
 
Since registration efficiency calibration is the basis for correctness and accuracy of 

measurements, these operations must be fulfilled by a highly qualified specialist, or a representative 
of the company in charge of supply and setting of the gamma spectrometer. 

 
9.2 Selection of radionuclides for calibration  

 
Calibration requires sample measures of activity or calibration sources (hereinafter referred 

to as calibration sources) with activity within the range (1 - 100) kBq, produced based on working 
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standards of radionuclide solutions of the 1st order 54Mn, 57Co,109Cd, 113Sn, 137Cs, 139Ce, 152Eu, 
241Am, 243Am, 226Ra (with daughters), 228Th (with daughters), etc. 

 The activity of the calibration source is chosen based on the condition that, when setting a 
spectrum in the working geometry of measurement, “dead” time does not exceed (4-5)%. 

The quantity and radionuclide composition of calibration sources for the efficiency calibration 
task in the range of energies 50 – 3000 keV is chosen, assuming that no less than 4 efficiency 
values, which correspond to different energies of gamma-quanta, should be received in the interval 
of energies 50-200 keV, and also energies must correspond to the beginning, middle and end of the 
energy range, and no less than 4 efficiency values meeting the same requirements should be 
received in the interval of energies 200-3000 keV. 

 
9.3 Efficiency calibration procedure 
 
9.3.1 Measure spectra of sample measures or simulate these spectra using the programme 

implementing calculation methods. 
9.3.2 Generate files of passport data of calibration sources. To do this, use the Passport of 

source editor window, which can be opened from the main programme menu Options-> Passport 
of source editor (see section 13). 

9.3.3 Process the spectra received in p.9.3.1 for the purposes of searching, identification and 
determining areas of peaks as described in section 6. 

9.3.4 For each spectrum of the calibration source, set its own file of passport data. To do this, 
specify a link to the file of passport data in the Passport of source field in the Spectrum 
parameters window of each spectrum. 

9.3.5 Save processed spectra to a disc. 

9.3.6 Open the Efficiency calibration window (see Fig. 48) by pressing  on the toolbar 
of the programme. Choose tab Efficiency calibration which is the first tab in the window’s title. 

 
 

 
Figure 48. Efficiency calibration window view 
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Block 2 

Block 3 

Block 1 

Block 5 

Block 6 
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 9.3.7 In tab Efficiency calibration, using Add on the toolbar, load all the calibration spectra, 
then range them in such a way that the spectra with one density (or other parameter) are grouped. 
(See example on Fig.49). 

     
 

Figure 49. Ranging of spectra 
9.3.8 Set parameters of the efficiency curve (Fig. 48, block 1): 
 - Parameter (Density) – the parameter, according to which the programme will plot 

different curves. Thus, for instance, when the list of spectra contains samples with three different 
densities of material 0.2 g/cm3, 1 g/cm3 and 2 g/cm3, the programme will plot three independent 
efficiency curves. Then, when a file with these curves is used, the programme will interpolate values 
of efficiencies taking into account the real density of material of the countable sample. 

- Polynomial degree – the parameter determining the polynomial degree, which will be 
calculated for the purposes of describing experimental dependence of registration efficiency on the 
energy of gamma-quanta. 

- Range, keV – the range of energies, within which the dependence of the registration 
efficiency on the energy of gamma-quanta will be built. 
 9.3.9 Press Calculate calibration (Fig. 48, block 1), then the table (Fig. 48, block 2, and 
Fig.50) will show a tree with data on efficiencies, and the graph below will display the curves 
approximating calculated points of values of efficiencies (Fig. 48, block 3, and Fig.50). 
 For each parameter (density), polynomial coefficients of approximation are displayed (near 
the value of this density), which look like this (example): 
 

Eff=f(-1343, 1307, -5133, -1649, 248.2, -19.85, 0.6592) 
 

 9.3.10 The points, which are at a good distance from the curve, are rejected by unchecking 
the relevant row in the table, and the appearance of the curve changes automatically. To change the 
energy range for calculation of efficiency curve, specify the values in the fields and click button. 
 9.3.11 To explore the shape of received curves, you can toggle the scale to the logarithmic 
mode. To do this, you should check Log located on the panel (Fig.48, block 1). The appearance of 
the graph will change, and will look as shown in Fig.50.1. 
 9.3.12 When the appearance of efficiency curves has finally shaped, an efficiency calibration 
file for the accepted measurement geometry is created, which has a unique name and an *.efp 
extension. To do this, press Create file and then enter the name of the new calibration file in a 
standard dialogue.  

  Spectra of samples with 
density 0.2 g/cm3 

  

  

Spectra of samples with 
density 1 g/cm3 

Spectra of samples with 
density 2 g/cm3 
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Figure 50. Efficiency calibration window view after calculation of dependence of efficiencies on 

energy 
 

 
Figure 50.1 View of efficiency curves on a logarithmic scale 

 
9.4 Management of spectra 

 

 To load and delete spectra in the Efficiency calibration window, use  
buttons on the toolbar of the window.  
 After spectra have been loaded, their list appears in a table (Fig.48, block 4) or as shown on 
Figure 50. Histograms of spectra are displayed on a graph (Fig.48, block 4 or Fig.50). 
 To show or hide a histogram of a spectrum, check or uncheck it in the first 'N’ column of the 
table. 
 The information with parameters of the current (selected in the table) spectrum is displayed 
on the panel under the graph of spectra (see Fig.48, block 6). To be noted, the histogram of the 
current spectrum is displayed on a graph with a bold red line.  
 To move the current spectrum up or down the table, use  or  buttons. 
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9.5 Creating an efficiency file project 
 
 As creation of an efficiency file may take a longer time, saving a current configuration of 
calibration spectra, selected energies and parameters for further operation might be relevant. To this 
end, one can save the current configuration as a separate project file. What is more, all the spectra, 
library files and passport data files will be moved to a common directory featuring a certain 
structure. 

 To create a project file, click button  in the toolbar of tab Efficiency calibration.  A 
window will appear on the screen. In this window, specify the name of the project and directory, 
where the project itself and all the relevant files will be moved (one is recommended to create a new 
directory) (see Fig. 50.2). 
 

 
Figure 50.2 Window requesting the name of an efficiency file project and a directory for it 

  
Click button Save to create three subdirectories SPC, LBR  and PKS in the project’s 

directory specified by user. The spectra, library files and passport data files related to them will be 
automatically copied to the respective subdirectories. In the project’s directory, there will appear a 
*.pef file which contains the data on the project’s parameters. 
 Later on, when GammaPRO is closed and then opened again, the user will be able to load 

the project by clicking button  in the toolbar of tab Efficiency calibration and selecting the 
saved project’s file there. The software will automatically load all the spectra and restore the 
configuration saved, so that the user will be able to continue creating the efficiency calibration file. 
  

9.6 Creating an efficiency file from a text table 
 
 Tab Converting in window Efficiency calibration is used to convert the text table (text file) 
which contains three value columns (energy, efficiency and standard uncertainty) to the efficiency 
file of the GammaPRO format.  
 To this end, the user should choose tab Converting (see Fig. 50.3) and open the text file by 

clicking button  in the tab’s toolbar. Once the file is opened, the software immediately starts to 
perform calculation in accordance with the parameters (degree of a polynomial, energy range) 
specified in the toolbar. These parameters are changed in the same way as in tab Efficiency 
calibration . The values in the table can also be turned on and off by ticking each row in the first 
column named Energy. The resulting polynomial function of the detection efficiency versus energy 
will be displayed in the toolbar. 
 When calibration is created, it should be saved as an *.efp file by clicking button Create file 
in the tab’s toolbar. 
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Figure 50.3. Tab Converting 

 

10 Parameters 
 
 The Parameters window of the table is intended for setting some details of work of the 
programme. It can be opened from the main menu Options->Parameters and contains 4 tabs 
General, Files, View, Calculation (see Fig.51). 
 

 
Figure 51. Parameters window view 

 
 The General tab (Fig. 51) contains a block of parameters GPS, which has two fields for 
setting a GPS satellite navigation unit. If a GPS receiver is connected and data are correct, the 
current coordinates can be sent to fields of the GPS coordinate group. 
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 The Files tab (Fig. 52.1) contains the name of the database file for saving the results of 
calculation of activities of radionuclides (Database filename field) and the protocol filename 
(Protocol filename field), which can contain the consolidated result of measurements in a text 
format. 
 

 
Figure 52.1 Files tab view 

 
 The View tab (Fig.52.2) is intended for setting the external interface of the device manager. 

 
Figure 52.2 View tab view 

 
 The Calculation tab (Fig.52.3) is intended for setting some aspects related to measurements 
and the procedure of calculation of activities.  
 

 
Figure 52.3 Calculation tab view 

 
 The Calculation tab contains several blocks containing the following fields: 
 Calculate Aeff – an indicator telling the programme that it needs to calculate a parameter of 
efficient activity, which is determined according to formula 10.1 (for details see Annex 5): 
 

Аeff = АRa +1.30·ATh +0.090·AK     (10.1) 
 where АRa is specific activity of radionuclide Ra-226, Bq/kg; 
 АTh is specific activity of radionuclide Th-232, Bq/kg; 
 АK is specific activity of radionuclide K-40, Bq/kg. 
 Efficiency activity is determined, when activities are calculated according to the ROI-method 
or peak analysis method and is displayed on the results panel as shown on Fig.30. The calculation is 
made, if there is a calibration for determining activities of natural radionuclides (NRN). 
 Save measurement in log – an indicator telling the programme that it needs to automatically 
send the measurement results to a log in the process of saving a measured spectrum. 
 Signal about measurement finish – a checkbox, which allows to enable and disable a sound 
signal at the end of spectrum writing. 
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 Type of view results with uncert. more 50% – an item for choosing the format of display 
of the measurement result with expanded uncertainty above 50%. Values may be displayed in two 
formats: 
 "<MDA" 
 "MDA/2 ± 100%". 
The first result output variant is more correct from the point of view of metrology. 

 
 11 Pack of spectra 

 
 The Pack of spectra module is opened from the main programme menu Tools->Pack. It is 
intended for work with any series of spectra (display, mathematical operations, determination of 
stability, calculation of activities, etc.). 
 
 

  
Figure 53. Pack of spectra module 

  
 The Pack of spectra module consists of three main blocks and a menu (Fig.53).  
 Block 1 is a table, which contains the list of loaded spectra. The first column of the table 
contains a spectrum number in sequence and a checkbox, which shows whether this spectrum should 

be displayed in block 2. When you press on the column header , it enables or disables 
displaying of all the spectra. 
 The second column contains filename of spectra with their paths. Columns 3, 4 and 5 are 
intended for the display of results by determination of stability (see below). 

Block 2 

Block 3 

Block 1 

Switching between linear and 
logarithmic scale  

Switching 
between count and 

intensity 
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 If a cursor is set in any row, the spectrum concerned is shown on the graph in red. You can 
select one, two and even all the rows in the table. The last selected spectrum has a red bold line on 
the graph. To select several spectra, press and hold Ctrl on the keyboard and press on the row you 
want to select with the left mouse button. If you want to deselect a row, press with a left mouse 
button on any selected table cell. A left double click on any row causes standard opening of a 
spectrum within GammaPRO. 
  
 Block 2 contains a graph, which displays on the selected spectra in the table on a single 
automatic scale. 

 Press the  button in the menu to add spectra to the table, or press the  button to 

delete, first selecting necessary spectra in the table. To delete all the spectra at once, press .  
  
 Block 3 is intended for management and all kinds of operations in the Pack of spectra 
module. It consists of several tabs (Current, Math. operations, Stability, Activity, Cal ibration, 
Sensitivity control, Background control, Normalization, Map), each of which is responsible for 
respective functions.  
 The Current  tab (see Fig.53) displays all the information about parameters of the last 
selected spectrum in the table (block 1). The list of parameters on the Parameters and Additional  
tabs fully duplicates the list provided on the “Spectrum parameters” tab (see Fig.20 and Fig.36) 
when you work with the spectrum window.  

 There are two buttons on the toolbar of the Current  tab:  (Save current change) and  
(Template). The first is for saving changes made to fields of the Parameters and Additional  tabs. 

The  button provides the user with a Template tool, which is intended for measuring one or 
several parameters of selected spectra. When you press this button, the Template of parameters 
window (see Fig.54) will open. 
 

 
Figure 54. Template of parameters window 

 
 Edit one or more parameters and check this field on the right. Then, in the main list of 
spectra, select the spectra, to which these changes should be applied, then press Apply  in the header 
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of the Template of parameters window. As a result, you will see a message about the manipulation 
you have made.  
 The  (Get parameters of current spectrum) button is necessary in the cases, when it is 
necessary to get parameters of one spectrum and use them as a template for other spectra.  
 
 The Math. operations tab consists of 3 blocks (Fig.55) and is intended for summing and 
subtracting spectra. 

 
Figure 55. Math. operations tab content 

 
 To add several spectra and make them one: 
   - select the spectra intended for summing in the main table (Fig.53, block 1); 
   - select ‘Sum’ in the dropdown list of the Operation field (Fig.55); 
   - select the option corresponding to the type of summing (channel-by-channel or in the 
energy scale); 
   - in the Ext.parameters block, select Spectrum as shown on Fig. 55, the field with the 
dropdown list should be empty; 
   - in the Result block, select Filename for new spectrum, press  in the field below and 
select a path and the name for the sum spectrum. 
   - press Calculate. A new summary spectrum will be created as a result of the actions above. 
 There is a Sum time checkbox in the Ext.parameters block. It is intended for changing the 
type of the resulting summary spectrum by time criterion. Thus, for instance, you should check this 
checkbox, when summing spectra of the same type received from one detector or from one source. 
By doing this, you will sum count and time in the resulting spectrum. Thus, we will receive an 
averaged spectrum with improved statistics. In other case, when summing spectra from difference 
sources, disable the “Sum time” mode. Then the resulting spectrum will have time as the first 
spectrum being summed (the so-called adjustment to the time of the first spectrum). 
 To add several spectra with one spectrum: 
   - select the spectra intended for summing in the main table (Fig.53, block 1); 
   - select ‘Sum’ in the dropdown list of the Operation field (Fig.55); 
   - select the option corresponding to the type of summing (channel-by-channel or in the 
energy scale); 
   - in the Ext.parameters block select Spectrum as shown on Fig. 55; 
   - in the field with the dropdown list select the spectrum, with which you will sum the 
spectra selected in the table; 
   - in the Result block, select Mask for new spectra, and in the field below enter a mask, for 
new spectra, to make them different from the original ones; 
- press Calculate. 
 As a result of this, files of spectra summed with one spectrum will be created on a disk. 

 
To subtract a spectrum from several spectra, you should do the same operations with the 

exception of the type of operation in the Operation field. You should select ‘Sub’ here. 
Spectra can be summed and subtracted with a constant. To do this, in the above-mentioned 

algorithms specify Constant instead of Spectrum and enter the constant value in the field below. 
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The Stability  tab is intended for determining stability of the spectrometric tract by spectra. 

Thus, for instance, to receive a graph of dependence of the 137Cs radionuclide peak position in a 
spectrum on time, the set of spectra should be measured in an automatic mode. Load the received 
pack of spectra to the Pack of spectra module. Select all the spectra. On the Stability tab (Fig.56, 
block 1) in the Find in range block, specify the approximate location of the peak, check Centre and 
press Calculate. Fill in columns 3, 4 and 5 in the module table. The graph on the Stability tab will 
show the dependence you seek.  You can copy the received graph to clipboard by pressing To 
clipboard. To make selection of the window with the peak easier, use Auto (in the Find in range 
block). This button gets fixed in this state, when you press it. Then, you can double click with a 
marker on the spectrum in the place of the left window edge and then in the place of the right edge. 
The graph range will get selected (see Fig.56). Then you can press Calculate again. 

 

 
Figure 56 

 
 Sigma, Resolution, Integral  and Intensity checkboxes are intended for displaying on the 
graph not only the centroid of the peak, but also FWHM (full width at half maximum) value, 
resolution value calculated based on the peak shape, as well as integral and intensity. The Find in 
range group contains an option for entering window edges in channels and in energy values (keV). 
 
 The Sensitivity control tab (Fig. 57) is intended for detector sensitivity control. The 
programme evaluates the difference between measured and passport values of activities of 
radionuclides in the control sample taking into account errors in their determining. 
 

 
Figure 57. Sensitivity control tab view 

Block 1 
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 Select necessary spectra in the main table to perform the control. In tab fields, consecutively 
load the file of passport data of the control samples, the background spectrum and the file of 
calibration by ROI-method. Press Control . The result looks as shown on Fig. 57. 
  
 The Background control tab (Fig.58) is intended for a standard mathematical operation, 
which allows evaluating the unchangeability of the unit background by comparing the measured 
spectrum with the background spectrum. 

 
Figure 58. Background control tab view 

 
 Select necessary spectra in the main table to perform this operation. In fields of the 
Background control tab consecutively load the background spectrum and the file of calibration by 
ROI-method. Press Control . The result looks as shown on Figure 58. 
  
 The Activity  tab (Fig.59) is intended for the calculation of activity of radionuclides using the 
ROI-method. For a series of spectra, the procedure is the same as for a single spectrum (see section 
5.1). 
 

  
Figure 59. Activity  tab view 

 

Block 1 
Block 2 
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 It is possible to calculate activities for a series of spectra from the Activity  tab only using 
one calibration file and one background spectrum. To do this, select necessary spectra in the main 
table. In tab fields, consecutively load the background spectrum and the calibration file. Press the 
Calculate button. The result looks as shown on Fig. 59.  
 Block 1 on Fig. 59 has checkboxes, which will show the column in the results. Calculated 
activities and errors are shown in table as a tree. To look at the values of any specific spectrum, 

press on  in the respective row and hidden data fields will appear. If you need to show all the 
values at once, press on the Spectrum column heading, when you press again, all the fields will be 
hidden. 
 Under block 2 (Fig.59), there is the Calculate MDA checkbox. When checked, the table will 
display minimum detected activity and specific (volume) activity instead of activity, when relative 
error is higher than 50%. 
 Block 2 on the Activity  tab is for exporting results to data storages, for example, a text file, 
MS Word, a report and a database. Check one of the options in block 2 and press Transfer. The 
content of the resulting table will be transferred according to the selection. 
 

12 Radionuclides library editor 
 
The radionuclides library editor is intended for generation of files, which are used in the 

calculation of activities, identification of radionuclides and for other spectrometric tasks. These files 
should be shown in the Library file  field in the Identification  section of the Spectrum parameters 
window (Fig.20 and Fig.36). 

A library file contains the list of radionuclides with respective energy lines and their 
quantum outputs. The programme can handle library files of two types (*.bib and *.lbr ). The first 
one (*.bib) is a text file and has a structure of the so-called ini-file; the second one (*.lbr ) is also a 
text file, but it has other, more old-fashioned structure. Both files may be formatted and edited 
manually (in any text editor), or you can also use the Radionuclides library editor module. 

To open the editor, select Options->Library editor  in the main programme menu. A 
window shown on Figure 60 will appear on the display. 
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Figure 60. Radionuclides library editor window view 
 

 It looks like two symmetrically located blocks, which contain a table (block 1 and 2, Fig. 
60), a toolbar and a block of display parameters (blocks 3 and 4). The functionality of the blocks is 
absolutely the same, which allows forming libraries using elements of both. Use arrow buttons 
(block 5, Fig. 60) to move radionuclides from one library to the other. 
 The GammaPRO installation package usually contains one or more libraries, from which 
you can make individual libraries for specific tasks. To do this, you need to load an already available 

library from the toolbar editor to the left block using . Then select necessary radionuclides and 

press  (Copy selected radionuclides). Selected items will appear in the right table, then you can 
add something to it, edit and save it. Items from the right table can be copied to the left table in the 
same way. 
 To edit names of radionuclides, energies, etc., double click on the current value with the left 
mouse button and the field will switch to the editing mode. To finish editing, press Enter. 

 To add a radionuclide to the table, press  (Add radionuclide). A new row with the name 
of the radionuclide 'Nu' with one energy line will appear. The new row will appear above the 
currently selected row. To add a radionuclide to the end of the table, deselect the current selection. 
To do this, left click on the field under the table, to the right of theParameters group (Block 6, Fig. 
60). The new row should be edited according to characteristics of the item to be added.  

 To add energy line of a radionuclide, select this item with a cursor and press  (Add 
energy) on the toolbar. In the new row, you should replace default values with necessary ones 
(energy, quantum output, quantum output error). 

 To remove a radionuclide and its energy lines, use  (Delete selected radionuclides) and 
 (Delete selected energies), respectively. To clear the entire table, use the  (Remove all) 

button. 

Block 1 

Block 2 Block 4 
 

Block 5 Block 6 

Block 1 

Block 3 
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 When you have finished editing the table, you can save it in any of the two formats. To save, 

press  (Save library file) on the respective toolbar. Please note that the *.lbr library format does 
not support saving of the so-called “checking/unchecking” of items and their lines. 

 

13 Reference source library editor  
  
 The Reference source library editor is intended for generation of files of passport data of 
sources, which are used during efficiency calibration of the spectrometer. These files should be 
shown in the Source reference data field in the Identification  section of the Spectrum 
parameters window (Fig.20 and Fig.36). 

To open the editor, select Options-> Reference sources library editor in the main 
programme menu. A window shown on Figure 61 will appear on the display. 
 

 
Figure 61. Passport of source editor window 

 
 A passport of source file contains a list of radionuclides, their activity, uncertainly, as well as 
other parameters describing the source.  
 Figure 61 shows an example of completion of the form in the Reference sources library 
editor window.  
 Complete the following fields in the left part of the window: 
 Geometry – source geometry, the text field may be filled manually or its value can be 
selected from a dropdown list. 
 Mass  | Unit – source weight and weight unit. 
 Volume | Unit – source volume and volume unit. 
 Reference date and Reference time – date and time of adjustment of activities specified in 
the table to the right. Please note that all the activities in the table must be adjusted to this date and 
time. 
 ID source – source identifier or number, a text field. 
  
 On the right side of the Reference sources library editor window there is a table, where the 
user should enter data about radionuclides present in the source. To add a row, press  (Add 
radionuclide) above the table. Then, it is necessary to fill empty fields with values from the source 
certificate. To make it easier to enter the data about the name of the radionuclide, the user may 
select it from the list, which appears in the editing mode in the 'Radionuclide' field (see Fig.61.1). 
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Figure 61.1 Selection of a radionuclide from the library 

  
 To make a dropdown list available, it should be loaded from a library file in format described 
in Section 12. To load a library file, double click on the status bar of the window and load the 
required file using a standard file selection dialogue. The name of the loaded file will be shown on 
the status bar. 
 To delete a row or clear all the list of radionuclides shown in the table, use  (Delete 
radionuclide) and  (Delete all radionuclides) buttons, respectively. 
 To finish the creation of a passport of source file, save it as a file. To do this, press Save on 
the toolbar of the window and specify a new filename.  
 To load an existing passport of source file for viewing and editing, use the Open button.  
 

14 Calibration for activity calculation by the ROI-method 
  

14.1 General provisions 
 

 The GammaPRO software enables calculation of (specific) activity of radionuclides in a 
count sample by the ROI-method considering calibration files which contain calibration sensitivity 
coefficients calculated in accordance with paragraph 14.4. 

 The software also enables direct calculation of calibration sensitivity coefficients. 
 Calibration of detection sensitivity of a spectrometer is performed by means of activity 

reference samples featuring the shape of and gamma radiation absorption within the count sample. 
The calibration can be regarded to consist of the following stages: 

– acquisition of spectra irradiated by reference activity samples or calculation of such 
spectra by means of special purpose software which simulates interaction between 
radiation and matter; 

– acquisition of background spectrum; 
– creating a *.clb calibration file and saving it.  

 
 The format of a *.clb file can be found in Appendix 1.  
 
A proper calibration underlies correct and accurate measurements. This is why such an operation 
shall be performed by a skilled expert, alternatively, an employee responsible for delivery and 
adjustment of the spectrometer. 

 
14.2 Creating a calibration file 
 
14.2.1 Acquire spectra of reference samples or simulate these spectra be means of software 

which implements calculation methods. 
14.2.2 Load module Pack of spectra (see section 11). 
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14.2.3 Load all the calibration spectra into this module and then sort them, so that the spectra 
of a radionuclide are grouped together (refer to the example in Fig. 49. 

14.2.4 Make sure that the parameters of the samples’ spectra such as mass, volume, energy 
calibration are correct, and background spectrum is chosen. These parameters are displayed in tab 
Current-Parameters and additional tab Current- Additional  (see Fig. 53, block 3). 
 
 14.2.5 Select tab Calibration  in module Pack of spectra and specify a radionuclide, its 
activity (in Bq) and the corresponding certification date for each spectrum in block Aprior activity 
of current spectrum (see Fig. 2, block A).  
 
 
 

 
 

Figure 62 
 
 
 To this end, mark the first spectrum in the spectrum list (Fig. 62, block E) and click button  
(see Fig. 62, block A).  In column Nuclide of the string which will appear below, choose the 
radionuclide from the drop-down list. Specify the activity or radionuclide concentration in the 
reference sample in column Activity . Specify the certification date of the radionuclide activity or 
concentration in column 'Date'. Then click button  to save the data. The procedure described is 
applied to each spectrum in the main table (Fig. 62, block E). 
  
 
 14.2.6 Choose appropriate geometry in field Geometry (Marinelli 1L, 0.25L vessel and so 
on, see Fig. 62, block B). 
 14.2.7 In field Window (see Fig. 2, block C), specify the file which contains the data on the 
energy regions to be considered in calculation (see paragraph 4.1 of Appendix 4). 
 14.2.8 If necessary, fill in field Comment. 
 14.2.9 Click button Calculate calibration. 
 14.2.10 All the calculated calibration sensitivity coefficients will appear as a tree structure in 
field Calibration data (see Fig. 62, block D).  
 14.2.11 Click button Create file to save the calculation results as a calibration file (*.clb) to 
disc (see Appendix 1). 
 14.2.12 By clicking button Create list of calibration spectra, one can create a calibration 
spectra list file (*.lcs) which is used for activity calculation by the superposition method (see section 
5.4). It is recommended to create separate folders for calibration spectra, background spectra and list 
file. 

Block А 

Block B 

Block C 

Block D 
Block E 
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14.3 Calibration for content calculation 

  
 In case the spectrometer should be calibrated in units of measurement different from Bq, for 
example, mass fraction, percent and so on, the calibration procedure remains the same as described 
in section 14.2. The certified values of the samples and their units of measurement are specified in 
the table (Fig. 62, block A) with no changes according to paragraph 14.2.5. At the same time, one 
must additionally edit the output calibration file (*.clb) and specify the proper units of measurement 
in the string containing the radionuclide’s name as shown in the example below. 
 

…  
4 
Cs-137     (Unit="kBq/sq.m") 
1  1.000  
K-40       (Unit="Bq/kg") 
1  1.000  
Ra-226     (Unit="%") 
1  1.000  
Th-232     (Unit="ppm") 
1  1.000 
… 

 
 If the measurement unit is not specified, it is presumed to be Bq by default. 

In order to obtain the result of calculation of radionuclide content in user’s units of 
measurement, switch the calculation mode to Content (see section 2.4.4, Fig. 15). 
 
 

14.4 Calibration coefficients 
 
 The ultimate goal of calibration of a spectrometric tract by the windows method is generation 

of a matrix of calibration coefficients, each of which corresponds to the energy window, 
radionuclide and density of a reference sample. 

The number of energy windows is selected to be equal or exceeding the number of the 
radionuclides used for calibration.  The energy windows as such are determined by regions of 
interest which are related to full energy peaks for each radionuclide used for calibration. 

Calibration sensitivity coefficients are calculated in accordance with the formula for count rate 
in each j:th window of an acquired spectrum of a count sample: 

bjij
i i

i
j SS

A

X
S +⋅=∑: ,   i=1..m      (14.4.1), 

where m is the number of unknown radionuclides in the count sample; 
Xi  is the unknown activity (to be calculated) of the i:th radionuclide in the count sample 

featuring a certain density ρx, Bq (Bq/kg); 
Ai  is the activity of the i:th radionuclide in the “reference” sample featuring a certain density 

ρx, Bq (Bq/kg); 

ij
S is the count rate in the j:th window of the “reference” spectrum of the i:th radionuclide 

excluding the background count rate, cps; 



 63

bjS is the count rate in the j:th window of the background spectrum, s-1. 

 Value 
i

ij

A

S
in formula (14.4.1) is the sensitivity coefficient for window j, radionuclide i 

and density ρx . Considering this, the formula for calculation of calibration sensitivity coefficient s is 
as follows: 

ri

rij

ijr A

S
C = ,   r =ρ0…ρd,    (14.4.2) 

where ρ0…ρd is the density of reference samples used for calibration, g/cm3;  

ijrC is the sensitivity coefficient for window j and radionuclide i in the spectrum of a sample 

featuring density r, cps/Bq (cps/Bq·kg);  
ρ0…ρd are the density values of the reference samples used for calibration, g/cm3; 
d is the number of density values used for calibration; 

rij
S is the count rate in window j of the spectrum of reference sample with radionuclide i 

featuring density r excluding background count rate, cps;  
Air is the activity of radionuclide i in the reference sample featuring density r, Bq (Bq/kg). 
 

For each measurement geometry, the result of calibration (a *.clb file) is an own matrix of 
sensitivity coefficients in accordance with formula 14.4.2. 
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15 Licence 

 A standard version of GammaPRO is protected by a USB license dongle. This means that 
the USB license dongle should be inserted in the PC when the software is being launched or 
operated. The root directory of the dongle must contain file sn_key.dat .The file mentioned contains 
the generated coded data on the dongle in question. If there is no license data, the software will 
perform in the demo mode during 10 minutes, then it will warn about demo version status and 
terminate the operation. During this 10 minute demo mode, measurements cannot be started, and 
there will appear messages warning about missing license. 

Thus, GammaPRO is in the demo mode if: 

• no USB licence dongle is inserted in the PC; 
• there is no sn_key.dat file in the root directory of the license dongle; 
• the USB licence dongle does not comply with the data contained in file sn_key.dat. 
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Annex 1. Calibration file structure (*.clb) 

The content of the calibration file is italicised. 
Marinelli 
ADC Polynom S/N 16 
BDEG-63-63 
 
6 
 612.0   709.0 0.99 0.97 0.95 
 870.0  1000.0 0.99 0.97 0.95 
1068.0  1178.0 0.98 0.95 0.92 
1385.0  1540.0 0.99 0.97 0.95 
1677.0  1846.0 0.99 0.97 0.95 
2500.0  2720.0 0.99 0.97 0.95 
4 
Ra-226    (Unit="kBq/sq.m") 
3  0.200  0.900  1.700   
Th-232 
3  0.200  0.900  1.700   
K-40 
3  0.200  0.900  1.700   
Cs-137 
3  0.200  0.900  1.700   

Name of geometry of measurements 
Three rows for any comments 
 

Number of working windows 
Bottom and top edges of work windows, as well as 
coefficients of shielding for each density and window. 
 

Number of radionuclides in the matrix 
Radionuclide and units of measurement 
Number of attested densities and density in g/cm3 

 
 
 
 
 
 

 
 
0.012518  0.004974  0.006181  0.004008  0.004754  0.000082 
0.012386  0.004851  0.005869  0.003725  0.004530  0.000085 
0.011181  0.004716  0.005408  0.003491  0.004011  0.000103 
 
 
0.008251  0.016280  0.002369  0.002162  0.001555  0.004037 
0.007594  0.014390  0.002190  0.001980  0.001367  0.003551 
0.007546  0.013330  0.002031  0.001896  0.001381  0.003587 
 
 
0.000385  0.000529  0.000504  0.001908  0.0       0.0 
0.000364  0.000570  0.000556  0.002064  0.0       0.0 
0.000343  0.000473  0.000474  0.001720  0.0       0.0 
 
 
0.030660  0.000012  0.000003  0.0       0.0       0.0 
0.028320  0.000020  0.000006  0.0       0.0       0.0 
0.027240  0.000025  0.000008  0.0       0.0       0.0 

Sensitivity,  
for the first 
nuclide (с-1Bq-1) 
in work windows 
(rows) and for 
each density 
(columns) 
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Annex 2. Efficiency file structure (*.efp) 
 

Efficiency Eff  calculation for energy En is made using the formula: 

Eff(En)=Exp[A0+A1*lnEn+A2*(lnEn)
2+A3*(lnEn)

3+A4*(lnEn)
4+A5*(lnEn)

5 +A6*(lnEn)
6]. 

 
 [Main]      
Count=3 
En_1=50 
En_2=3000 
[Item_1] 
Ro=0.19 
dA=0.000120673701486547 
A0=100.952521999333 
A1=-193.624766139809 
A2=113.539550219905 
A3=-31.4152431368484 
A4=4.55284676290508 
A5=0 
A6=0 
A_up0=-239.089407209938 
A_up1=154.712894929183 
A_up2=-37.6090565833576  
A_up3=4.0180585277374  
A_up4=-0.160073518024323  
A_up5=0 
A_up6=0 
A_down0=-242.411794019549 
A_down1=156.961174786668 
A_down2=-38.1739234808294 
A_down3=4.07993324404847 
A_down4=-0.162573133753684 
A_down5=0 
A_down6=0 
 
Count_point_eff=8 
Point_eff1=Ra-226;186.1;0.0289146;0.036 
Point_eff2=Ra-226;241.98;0.0230479;0.036 
Point_eff3=Ra-226;295.21;0.0201344;0.036 
Point_eff4=Ra-226;351.92;0.0176451;0.036 
Point_eff5=Ra-226;609.31;0.01006;0.036 
Point_eff6=Ra-226;768.36;0.00867296;0.036 
Point_eff7=Ra-226;1120.3;0.00628238;0.036 
Point_eff8=Ra-226;1764.5;0.00447472;0.036 
[Item_2] 
Ro=1 
dA=6.98283591165722E-5 
A0=-472.240982213604 
A1=394.832631929211 
A2=-135.275425911041 
A3=24.0371788273522 
A4=-2.32009207827529 
A5=0.113556756070361 
A6=-0.00213719932431744 

Main block heading. 
Number of densities. 
Interval of energies, 
 to which the curve corresponds. 
First curve block heading. 
Density corresponding to the first curve. 
First error approximation error. 
Coefficient  A0 
Coefficient  A1 
-//- 
-//- 
-//- 
-//- 
-//- 

Polynomial coefficients of the upper boundary of 
the confidence interval of the efficiency curve 

 

 

 

 

Polynomial coefficients of the lower boundary of 
the confidence interval of the efficiency curve 
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Annex 3. Passport of source file structure (*.pks) 
The content of the passport of source file is italicised. The file has a structure of a standard 

INI file. 

[Main] 
Count_nuclide=4 
Date_reference=18.04.06 
Massa=0.314 
Volume=0.25 
Unit_weight=kg 
Unit_volume=l 
Geometry=Marinelli 
 
[Nuclide_1] 
Activity=5400 
Abs_Err=540 
Name=Ra-226 
 
[Nuclide_2] 
Activity=2100 
Abs_Err=210 
Name=Th-232 
… 

Main section name. 
Number of nuclides in KO. 
Data, on which the activity is adjusted. 
KO mass. 
KO volume. 
KO mass unit. 
KO volume unit. 
Name of geometry 
 
First radionuclide section name. 
Activity, Bq. 
Absolute error, Bq. 
First radionuclide name. 
 
Second radionuclide section name. 
Activity, Bq. 
Absolute error, Bq. 
First radionuclide name. 
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Annex 4. Calculation of confidence interval for measurement error 
 
4.1 ROI-method 

x
iS )(  count in each i “window” in the spectrum of the countable sample may be presented 

as: 

j
i

j j

jx
i S

A

X
S )(:)( ∑ ⋅= ,         (1) 

where Xj is unknown (sought) activity of j th nuclide in the countable sample, Bq; 
Aj is activity of jth radionuclide, Bq in the reference sample; 

j
iS )(  is count in ith window of the library (reference) spectrum of j th nuclide, с-1. 

The process of calculations is as follows: 
– calculate the speed of count in windows; subtract background count speeds from measured 

ones; 
– select activities of nuclides in the mixture using the method of the least-square method 

according to the system of linear equations (1); 
– calculate random errors in activities of radionuclides 

(σj ). 
A random error includes a statistical component and an error due to mismatch of the 

measured spectrum with the sum of contributions from spectra of sample sources. 
The error range of the activity measurement result (specific activity) ∆(0,95)j (with 

confidence probability Р=0,95) is found according to the formula (in percent): 

∆(0.95)j =К[Q+εj],                      (2) 

 where Q is the non-excluded systematic error of measurement. The value of Q is set in 
window Calculation parameters of subsection Error (see section 2.4.4); 

εj is confidence random error component of jth radionuclide: 
εj=L*σj,                   (3) 

where Student’s criterion L=1.96 (at confidence probability P=0.95). The value of L is set in 
window Calculation parameters of subsection Error (see section 2.4.4); 
K is coefficient determined from the table depending on the Θ/ σj relationship. 
 

 Table 1 
K 0.76 0.74 0.71 0.73 0.76 0.78 0.79 0.8 0.85 
Θ/ σi 0.8 1 2 3 4 5 6 7 8 

Θ value in percent is determined according to the formula 
2
4

2
3

2
2

2
11.1 θθθθθ +++⋅= ,                     (4) 

where Θ1 is spectrometer sensitivity coefficient error (Θ1 =7 %);  
Θ2 is countable sample measurement error (Θ2 =1 %); 
Θ3 is error due to a countable sample density error (Θ3 =3 %); 
Θ4 is methodical error due to mismatch between the countable sample and sample 
composition (Θ4 =5 %). 
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If the ratio Θ/ σj <0.8, the value of the confidence error of specific activity measurement 
result of the j th radionuclide in the countable sample is assumed to be equal to the random 
component of the measurement error σj 

j)95.0(∆ = Кεj 
If the ratio Θ/ σj > 8, the value of the confidence error of activity measurement result 

(specific activity) of radionuclides in the countable sample is assumed to be equal to the confidence 
residual bias of the range of the measurement result Q. 

i)95.0(∆ = Q. 

In GammaPRO, the following values of coefficients are used when calculating the 
confidence range of measurement error: 

L=1.96; (see parameter L in section 2.4.4) 

Q=0.1 (10 %)  (see parameter L in section 2.4.4). 

 
4.2 Determining activities of radionuclides by the individual peaks analysis method 
 
Select a single peak or a multiplet in the measured spectrum. Determine areas of the peaks. 

Calculate the radionuclide activity of a single peak according to the formula: 

kt

S
A

п

п ε
= ,                     (5) 

where Aп is the radionuclide’s activity, Bq; 
S is peak area, imp; 
t  is live spectrum writing time, sec; 
k is quantum output of the selected radionuclide line; 
εεεεп is full efficiency of registration of quanta of this energy, с-1/Bq. 
Efficiency is found according to the formula: 

)6(),)(ln)(ln)(ln)(ln)(lnlnexp( 6
6

5
5

4
4

3
3

2
210 ппппппп

EAEAEAEAEAEAA ++++++=ε  

where Еп is energy corresponding to the gravity centre of the peak, keV; 
Ai is polynomial coefficients approximating dependence of efficiency on energy. 
 
The standard total relative uncertainty of the activity is calculated in the following way: 

22
SA uuu ε+=   , (7) 

where Su  is the standard relative uncertainty of peak area S; 

εu  is the standard relative uncertainty of detection efficiency εεεεп 
 

Su  is determined in the following way:  

t

n2n

n

1
u b

s
s

⋅+= ,  (8) 

 where nS  is the count rate in the peak without taking background into account, pulse/sec; 
n is the count rate delivered by both the source and the background, pulse/sec; 
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nb  is the count rate delivered by background only, pulse/sec; 
 

εu is determined by the value of the uncertainty of the efficiency which is considered as a 

polynomial function similar to (6) and calculated at the stage of efficiency calibration. 
 

Activity values calculated for a few peaks (i) of one and the same radionuclide are averaged 
in the following way: 

,
w

wA
A

2
i

2
ii

∑
∑=

  (9) 
where i is the peak number; 

wi is the contribution of peak i. This value is inverse of Aiu ;  

Ai is the activity of the radionuclide calculated by peak i, Bq; 
The total relative uncertainty of the activity is hence equal to: 

 

∑
=

2
i

A w

1
u

 (10)

 

 
The expanded uncertainty of the activity measured is expressed by the following formula: 

  

kuU AA ⋅=    (11) 
 
 where k is the coverage factor, k=2. 

 
 

 

Annex 5 Calculation of specific effective activity of natural radionuclides 

 
 The value of specific effective activity EffA  is calculated by GammaPRO using the formula: 

АEff = АRa +1.30ATh +0.090AK; 
 where АRa, ATh and AK  are specific activities of 226Ra, 232Th and 40K in the countable sample, 
respectively. 
 Absolute error EffA  ( Eff∆ ) is calculated according to the formula: 

2
K

2
Th

2
RaEff )090.0()30.1( ∆∆∆∆ ×+×+= , 

 where ∆Ra, ∆Th and ∆K are absolute errors of specific activities of 226Ra, 232Th and 40K in the 
countable sample, respectively. 
 The results of calculation of specific effective activity in natural radionuclides in countable 
samples are recorded as: 

EffEffA ∆± , Bq/kg. 
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